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How to use this
demo guide

This demo guide explains how to run the trial version of My Clients & Profits!, an add-on
web server that lets creatives, account executives, and out-of-office staff members access
the shop’s Clients & Profits database. This guide provides complete, step-by-step instruc-
tions for installing, setting up, and running the My Clients & Profits! demo software. (A
separate User Guide explains how web users log onto and use the My Clients & Profits!)

You’ll find many helpful screen shots throughout the administrator’s guide that illustrate
My Clients & Profits!’s management features and web capabilities. For more information
about the My Clients & Profits! web server, visit the My C&P! web site:

              www.clientsandprofits.com/my              www.clientsandprofits.com/my              www.clientsandprofits.com/my              www.clientsandprofits.com/my              www.clientsandprofits.com/my

There you’ll find up-to-date technical information about how the My Clients & Profits! web
server works, as well as tips, shortcuts, and troubleshooting ideas.
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Introducing My Clients & Profits!

My Clients & Profits! 5 is an add-on web server for your Clients
& Profits 5.x database that allows creatives, account executives,
and out-of-office staff members to track jobs, traffic, time,
expenses, and more from anywhere using any kind of internet-
enabled computer.

The My C&P! web server serves
customizable web pages using
real-time data from your
Clients & Profits database.
Users can add proposals, open
jobs, edit traffic and schedules,
review company and personal
calendars, update status
reports, enter hours on time
cards, and track costs using
only a web browser—and more.

My Clients & Profits!  acts as a
gateway between the shop's
Clients & Profits database and
any number of users either
inside or outside the office. A
user opens their web browser
then logs onto the My C&P!
server by entering a specified
web address (such as "http://
my.clientsandprofits.com"),
their user ID, and their password.
My C&P! verifies the user's ID
and password, then displays a
personalized home page. This
home page contains links to the various client, job, and costing
functions available to them, as well as links to company and
industry news, a company calendar, and an optional online
company handbook.

My Clients & Profits! maintains its own list of web users, so only
authorized people can use it. Hundreds of users can be sup-
ported, depending on your server hardware. Once connected to
the My Clients & Profits! web server,  staff members and
freelancers can perform many creative, production, and account
service (but not, for security reasons, accounting) activities.

Introducing My Clients & Profits!

No password, no access  The My
C&P! home page requires a valid,
active user ID and password before
allowing someone to access the
shop’s database.

My Clients & Profits! also lets authorized clients and vendors
access their information in your database. Clients can see their
account information, job tickets, client job status report, and
invoices. Vendors can see their own purchase orders. Each
individual who works at a client or vendor must have his or her
own My C&P! web ID and password, which prevents them from

seeing the work of other clients
and vendors. This keeps
important data private.

My Clients & Profits! is
available 24/7 (except during
nightly backups). It runs
unattended on a stand-alone
computer that is connected to
your Clients & Profits file
server. There is no preset limit
on the number of concurrent
My C&P! users, so many web
users can add jobs, time, and
expenses simultaneously.

The My Clients & Profits! web
server keeps track of every
request, or hit, in a log. This
makes it easy for a web server

administrator to track the server’s usage, including who’s using
it at which times. The web server administrator can remotely
monitor and manage the My Clients & Profits! web server from
home, a hotel room, an airport—anywhere there’s an internet
connection. My Clients & Profits! even sends instant e-mail error
notifications to the webmaster.

All of the My Clients & Profits! web pages are customizable.
A page’s design can be tailored to match your company’s visual
identity and style. This can make your My C&P! system look and
feel just like your web site for anyone who uses it.

�  The trial demo is a full-featured version of My Clients & Profits!
5.0 with a few limitations: The demo expires in 30 days after
starting, there’s a limit to five web users, and the log is limited to
1000 entries.
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Each My C&P! web user has
their own personalized home
page, whether they are a staff
member, freelancer, client, or
vendor.

A special “welcome”
message greets each My
C&P! user on their home
page. This greeting is
edited in the user’s Access
& Privileges window by the
web server administrator.

Clicking on a web
page’s help link
opens the My C&P!
online user guide.

Each web user can access
selected client, job, traffic,
and job costing functions
based on their My C&P!
access privileges. These
user-defined privileges work
together with the user’s
standard Clients & Profits
access privileges. Some
users will see more or fewer
links, depending on what
they are authorized to use.
The graphics used for each
link are GIFs that can be
replaced with your own
custom graphics.

The lookup lists in the My
C&P! web server look like
the ones in Clients &
Profits. They give web
users the same access to
client, job, vendor, and
other quick-reference lists,
as Clients & Profits users.

The Company News
section promotes company
propaganda, including new
hire announcements,
account wins, acquisitions,
and other newsworthy
stories.

The company calendar page
is linked to the Calendar
window in Clients & Profits,
listing company events,
meetings, and important
dates.

Staff members can stay
informed of industry news,
gossip, and events using
these customizable links.

My C&P! can serve pages from
a private, online company hand-
book. Your existing handbook
can be copied into web pages
(or use PDF files) that are easily
linked to the staff member
home pages.

Staff members can easily
access web sites that the
company deems valuable
by clicking on these links.

E-mail can be instantly
sent to the My C&P!
webmaster by clicking on
this link.

The My Clients & Profits! home page

The My Clients & Profits! Home Page
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Quick Start To install the My C&P!
web server demo

The My Clients & Profits! web server trial demo installs like the regular
Clients & Profits software, so the process is probably familiar: Insert the My
Clients & Profits! demo CD-ROM into a PC or Mac (or download the demo
installer), start the Installer application, then follow the prompts. Within
minutes, your new My Clients & Profits! software will be installed. The My
Clients & Profits! web server can be started once its preferences and web
users have been set up.

The My Clients & Profits! web server requires a dedicated Power Mac, iMac,
or eMac running Mac OS 9.1 or greater (including Mac OS X v10.2 or later)
or or or or or Pentium-based PC running Windows 2000/XP with 128mb of RAM,
25mb of hard disk space, a full-time TCP/IP connection to the internet, and
a full-time LAN connection to your Clients & Profits file server.  This
computer must have a fixedfixedfixedfixedfixed IP address that can be accessed outside of the
office.  Also, this computer should be dedicated to running My C&P!, so
shouldn’t be used for other web, mail, or file servers for best performance.

�  For up-to-date system recommendations for My Clients & Profits!,
please see www.clientsandprofits.com/sales/server_recs.htmlwww.clientsandprofits.com/sales/server_recs.htmlwww.clientsandprofits.com/sales/server_recs.htmlwww.clientsandprofits.com/sales/server_recs.htmlwww.clientsandprofits.com/sales/server_recs.html

My Clients & Profits! should only be installed on the server that will run it.
The My Clients & Profits! is fully self-contained. There is nothing to install
on the user workstations or on the Clients & Profits file server itself.

My Clients & Profits! is browser-independent, meaning anyone using any
kind of web browser can access the Clients & Profits database from any
kind of computer.

�  My Clients & Profits! 5 only works with Clients & Profits Classic 5.x,
Clients & Profits Pro 5.x, and Job Tracker 5.x or later databases (including
the My C&P! demo data.DF1 database, which is included).

The Clients & Profits web site features detailed technical information,
including up-to-date hardware recommendations:

www.clientsandprofits.com/mywww.clientsandprofits.com/mywww.clientsandprofits.com/mywww.clientsandprofits.com/mywww.clientsandprofits.com/my

Before installing My Clients &
Profits!, be sure that the computer
does not contain any prior versions
of Clients & Profits. Different
versions of C&P can conflict with
the My Clients & Profits! web
server and cause system problems.

11111  Insert the My Clients & Profits!
CD-ROM into your computer (or
download the demo installer from
the C&P web site).

22222  On a Mac, double-click on the
Installer. On a Windows-based PC
the installer application starts up
automatically, choosing the right
C&P Player to use on your version
of Windows.

The Installer will prompt you to
choose a destination for the new
My C&P folder. On a Mac, the hard
disk is selected. On a Windows PC,
the top level of your C: drive is
chosen automatically. Any volume
can be chosen.

3 3 3 3 3  Follow the prompts to finish the
installation.

A My C&P! folder will be copied to
your hard disk. Inside it you’ll find
a special web-enabled version of
the C&P Player, the My Clients &
Profits! 5.0 application, an HTML
folder that contains the My C&P!
web pages, and other program
files.

44444  Restart the computer.
For technical help, please call (800) 272-4488

To open the My C&P! web
server demo

11111  On a Mac, double-click on the
My C&P! application. On a
Windows-based PC, choose Start >
Programs > My Clients & Profits!

The first time My Clients & Profits!
is started, you will be prompted to
serialize the C&P Player.

22222  Enter your name, company, and
current Clients & Profits serial
number, then click OK.

There is no separate serial number
for My Clients & Profits!—you’ll
use the same one you’re using
now.  Once the C&P Player is
serialized, it will prompt you to
find and open a Clients & Profits
database.

33333  Find and open a Clients &
Profits database.

44444  Enter your Clients & Profits user
ID and password when prompted.

You must be a Clients & Profits
manager-level user to initially set
up the My Clients & Profits! web
server. Once My C&P! is running,
access to it is controlled by a
separate web user list (see “To Add
My C&P! web users” on page 7).
You’ll then see the My C&P! Web
Server Status window.  Before the
web server can be started, the
server’s preferences (including a
webmaster’s name and e-mail
address) and users must be
entered.

Quick Start

Your Clients & Profits Player serial number:

C SR8 M
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To add My C&P! web users

11111  Choose Setup > Users, Access &
Passwords.

22222  Choose Edit > Auto-Create Web
Users

The Auto-Create Web Users
window opens, listing all of your
current Clients & Profits users.

33333  Click OK.

Web user accounts are automati-
cally created for everyone who
currently uses Clients & Profits
now, using the same password for
the web server. Later, web access
privileges and passwords can be
changed for each user. Once web
user accounts are created, the My
Clients & Profits! web server can
be started.

�  For details about setting up
web user accounts for My C&P!,
see page 18.

To access the My C&P!
web server from a web
browser

11111  Open a web browser, such as
Internet Explorer or Netscape
Navigator.

22222  Enter the My C&P! web server’s
IP address or name, then press
Enter.

The My C&P! web server can be
identified by its IP address or by a
URL depending on how your
domain name is configured with
your ISP or internal DNS server.
An IP address would be entered
like “http://192.168.100.10” while
a URL could be entered as “http://
my.agency.com”. The URL can be
any name of your choosing.

33333  Enter your web ID and
password, then click Go.

If you’re successfully connected
you’ll see the My Clients & Profits!
home page. Your home page lists
the functions that you have access
privileges to use, such as clients
or jobs. Clicking on a link opens a
My Clients & Profits! web page.

To set my My C&P!
preferences

11111  Choose Setup > Preferences.

22222  Enter or select any of the
settings that seem appropriate to
your web server (see page 17 for a
description of each preference).

�  Be sure to enter the My C&P!
webmaster’s name, their e-mail
address, and address of your mail
server first. This enables the
server’s automatic e-mail notifi-
cations, which keep the web
administrator constantly informed
of server problems.

None of these settings are
required to actually use the My
Clients & Profits! web server.

33333 Click Save.

�  For details about setting My
C&P! preferences, see page 16-17.

To start the My C&P! web
server

11111  Choose My Clients & Profits! >
Start Web Server

Once started, My Clients & Profits!
begins listening for requests from
web users.  Every request, or hit,
from a web user makes a log entry
into the Web Server Status
window, so it’s easy to monitor
who’s using the web server.

Quick Start

Starting the web server Buttons to start and
stop the My Clients & Profits! web server are
found in the window’s toolbar.
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How My Clients & Profits! Works

The My Clients & Profits! web server acts as a gateway between your shop's
Clients & Profits database and any number of Internet Explorer or Netscape
Navigator users—whether in the office (your "intranet"), working at home,
in a client's conference room, or in a hotel room somewhere on the road.

My Clients & Profits! installs and runs just like the regular Clients & Profits
software. It uses the same C&P Player, so using it will be familiar to anyone
who's used Clients & Profits. My C&P! features an industry-standard HTTP
server for publishing custom web pages that include real-time data from
the Clients & Profits database. Users access My Clients & Profits! by
entering the web server's address, or URL. The URL can be the computer's
actual IP address (e.g., 192.168.100.55) or a custom domain name (e.g.,
"my.clientsandprofits.com"). In fact, the web address of the My C&P! can be
any variation of the shop's domain name. The web server is started by
opening the My C&P! application, opening your shop's C&P database from
the file server, then choosing the Start Web Server menu command. Once
the My C&P! web server has been started, it begins listening for incoming
HTTP requests from web users.

Any web browser can access the My C&P! web server as long as the user
has the right access privileges. Only authorized users can access the My
Clients & Profits! web server, which share access privileges with the user
list in Clients & Profits.

How the web administrator manages My Clients & Profits!How the web administrator manages My Clients & Profits!How the web administrator manages My Clients & Profits!How the web administrator manages My Clients & Profits!How the web administrator manages My Clients & Profits!

Only existing C&P system managers can configure the My Clients & Profits!
web server, including adding web users. Anyone can be added as a web
user, including clients, vendors, freelancers, and contractors—all with
specific access privileges to what they can and can't see and do. Any web
user can be a web server administratoradministratoradministratoradministratoradministrator and make changes to the My C&P!
server’s preferences, monitor the server’s status, and print web server
reports. One web administrator (typically the Clients & Profits system
manager) can be designated as the webmaster. webmaster. webmaster. webmaster. webmaster. The webmaster is the key
contact for anything My C&P!-related. The webmaster’s name and e-mail
address appears on error pages (so that users can contact him or her about
problems) and gets notified automatically via e-mail about web errors.

How staffers, freelancers, clients, and vendors will use My Clients & Profits!How staffers, freelancers, clients, and vendors will use My Clients & Profits!How staffers, freelancers, clients, and vendors will use My Clients & Profits!How staffers, freelancers, clients, and vendors will use My Clients & Profits!How staffers, freelancers, clients, and vendors will use My Clients & Profits!

From a user's point-of-view, using My Clients & Profits! is even simpler. A
user opens Netscape or Explorer then logs onto the My C&P! web server
using a special URL (e.g., http://my.clientsandprofits.com). An introduce
yourself page prompts them to enter their user ID and password. My Clients
& Profits! instantly verifies the ID and password, then displays a personal-
ized home page. This home page contains links to the various client, job,
and costing features available to them, as well as links to company and
industry news, a company calendar, and an optional online company
handbook.

Introducing My Clients & Profits!

Staff members and freelancers have full access (within the limits of their
access privileges, that is) to clients, jobs, time cards, expenses, and
purchase orders. Clients see their own account information, jobs, and Client
Job Status Report. Vendors see only their own purchase, insertion, and
broadcast orders. Web administrators have the same access as staff
members, but have links to monitor and manage the My Clients & Profits!
web server remotely.

My Clients & Profits! will let any number of web-based users access the
shop's database concurrently. To the database, the My Clients & Profits!
web server looks like any other user on the network.

�  My C&P! takes up one of the database's user slots (for example, a 10-
user version of Clients & Profits that also uses My C&P! will have 9 slots
available for non web-based users).

Padlocks, error checkingPadlocks, error checkingPadlocks, error checkingPadlocks, error checkingPadlocks, error checking

Unlike regular Clients & Profits users, web users don't have a full-time
connection to the shop's database. This means they won't get padlocks that
indicate record-locking, and losing the network connection can't damage
the database. Instead, each request is a separate transaction that's
received by the My C&P! web server, processed, then returned to the web
page in the form of a web page. Because there is no full-time connection to
the Clients & Profits database, there is no interactive error-checking when
a user tabs from field to field. Error checking only occurs when the
transaction is saved; if an error occurs (such as an invalid job number), the
My C&P! displays an error page to the user explaining what was done
wrong.

Performance factorsPerformance factorsPerformance factorsPerformance factorsPerformance factors

The performance of the My Clients & Profits! web server depends on three
factors:

(1) the speed of the internet connection,

(2) the speed of the server running the My C&P! web server, and

(3) the amount of traffic on the LAN and the Clients & Profits file server.

Stress in any of these areas will be noticeable to web users when they
request a web page or wait for data to be submitted (although data-entry
will be unaffected). Transactions from My Clients & Profits! have no greater
or lesser priority over regular Clients & Profits users—everything is handled
first-come, first-serve.
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The My Clients & Profits! web server acts as a gateway between your shop’s Clients & Profits 5.x database and any number of web-based users—
whether in the office, working at home, at a client location or on the road.

The My C&P! Flow Chart

I N T E R N E TI N T R A N E T

My C&P!
Web Server

Creative

Account Service

Clients &
Vendors

Out-of-Office
Staffers

Freelancers

C&P
SERVER

Accounting

Production

Media
Traffic

HOW IT WORKS: A user opens their web browser then logs onto the server using the special web address, a personalized ID, and password. My C&P!
verifies the user’s access privileges then displays a custom home page. This page features links to the various client, job, and costing functions plus
custom links to company and industry news, a company calendar, and an optional company handbook.
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My Clients & Profits! Features

GeneralGeneralGeneralGeneralGeneral

— My Clients & Profits! can be accessed inside or outside the office using
any internet connection.
— My Client & Profits! is a stand-alone application that runs on a dedicated
Power Mac or Windows-based PC; no additional software is needed.
— My Clients & Profits! is compatible with Internet Explorer, Safari,
Navigator, and all other web browsers (works best with IE).
— My C&P! serves real-time data-driven web pages, user-created HMTL
pages, and Acrobat PDF files.
— Access to My C&P! is available only to authorized individuals with their
own web account.
— Each web user has his or her own My C&P!-specific access privileges.
— The standard staff home page has customizable, user-defined links to
functions they’re allowed to use.
— Web accounts can be created for individual clients contacts, giving them
access to only their own jobs, traffic, and invoices.
— Web accounts can be created for freelancers, allowing them to enter
time and see work schedules.
— Vendors can be given web accounts to access their purchase orders.
— My C&P! web pages can be redesigned to fit the shop’s corporate
identity and visual style.
— My C&P! web pages can be customized in FrontPage, Dreamweaver,
BBEdit, and any other web design and site management application.
— Graphics, text, and links can be added to or removed from any web page.
— Additional data fields can be added using special OMFLD database tags.
— Customizable help pages offer online assistance for using clients, jobs,
time, expenses, POs, and traffic.
— A web-based version of the Clients & Profits In/Out board lets staff
members track when they arrive and leave the office.
— Staffers can use My C&P! to mark themselves unavailable for the day,
morning or afternoon.
— My C&P! web pages have help links to a detailed online user guide.— My C&P! web pages have help links to a detailed online user guide.— My C&P! web pages have help links to a detailed online user guide.— My C&P! web pages have help links to a detailed online user guide.— My C&P! web pages have help links to a detailed online user guide.

User-defined home pagesUser-defined home pagesUser-defined home pagesUser-defined home pagesUser-defined home pages

— Separate home pages are provided for staff members and freelancers,
webmasters, clients, and vendors.
— Custom company news pages can be created in FrontPage, GoLive,
Dreamweaver, or any other HTML editor then served by the My Clients &
Profits! web server. Staff members can keep up to date on new account
wins, new hires, company milestones, and more from the shop's own
private web site.
— Individual users can have completely custom home pages.
— Important dates of upcoming meetings, events, trade shows, parties and
more are available to anyone in the company from their web browser. Any
number of calendar pages can be created in any web page editor and
served by My Clients & Profits!
— Custom industry news links keep the company's employees current on
the big events in their industry, and all from a single home page.
— Important or useful links to outside web pages can be included on the

My C&P! home page. Standard links include the leading industry publica-
tions (e.g., Adweek, Advertising Age, HOW, Print, Communication Arts), the
Clients & Profits web site, and (just for fun) the American Advertising
Museum’s web site. These home page links are completely customizable.
— Staff members can read all about employment benefits, policies,
standards, and holidays from the online company handbook. The My C&P!
home page can be customized to display links to any number of company-
created employee handbook pages. Access to the company handbook, as
with the rest of My C&P!, is restricted to authorized users only. (Content
not included.)
— Employees can download expense reports, payroll change requests,
insurance, and other forms (either HTML pages or PDF files) any time
they're needed. (Content not included.)
— Home page GIFs are easily interchangeable with your own graphics.
— Links to clients, jobs, daily job status, time card, etc. are available to
users based on their access privileges.
— Lookup web pages show complete lists of clients, jobs, staff members,
vendors, status codes, the task table, groups, purchase/insertion/broadcast
orders, job type/spec sheets, and client projects.
— Real-time access to company and personal calendars.— Real-time access to company and personal calendars.— Real-time access to company and personal calendars.— Real-time access to company and personal calendars.— Real-time access to company and personal calendars.
— Web users can add calendar entries to the personal and company— Web users can add calendar entries to the personal and company— Web users can add calendar entries to the personal and company— Web users can add calendar entries to the personal and company— Web users can add calendar entries to the personal and company
calendar.calendar.calendar.calendar.calendar.

ClientsClientsClientsClientsClients

— The client web page features name, address, contact, and account
information.
— The client page includes links to client contacts, billing info, budgets,
the client diary, projects, stats, jobs, and invoices.
— New client diary entries can be added from My C&P!
— The Client Jobs page lists a client’s open and closed jobs, including
estimate, hours, billed, and unbilled totals.
— The Client Invoices page lists client’s billing history, including unpaid
invoices.
— New client projects can be added from My Clients & Profits!
— The Lookup Clients page lists all clients; clicking on a client number
opens the Clients web page directly.
— A client’s contacts can be viewed and edited.— A client’s contacts can be viewed and edited.— A client’s contacts can be viewed and edited.— A client’s contacts can be viewed and edited.— A client’s contacts can be viewed and edited.
— Proposals can be viewed, added, edited, and printed.— Proposals can be viewed, added, edited, and printed.— Proposals can be viewed, added, edited, and printed.— Proposals can be viewed, added, edited, and printed.— Proposals can be viewed, added, edited, and printed.

Job TicketsJob TicketsJob TicketsJob TicketsJob Tickets

— The job ticket web page looks like the Job Ticket window in Clients &
Profits, displaying the job’s number, name, contacts, and tasks.
— Users can find jobs by number or use the “Lookup Jobs” web page.
— The job ticket web page features links to the job’s specifications, work
order, creative brief, estimate, schedule, job snapshot, diary, and change
orders.
— Web users can open new jobs using job type/spec sheets.
— New tasks can be added to existing job tickets.
— Web users can edit a job’s specs, work order, and creative brief.

My Clients & Profits! 5 Features boldboldboldboldbold features are new in My Clients & Profits! 5.0
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— The start and due dates for a job's scheduling tasks can be entered,
reviewed, and updated from the Job Schedule web page.
— New jobs can be opened for any client, based on the user's access
privileges. If a new job is given a job type/spec sheet, My Clients & Profits!
will copy the template's tasks to the new job automatically.
— Estimates can viewed, edited, and approved/unapproved for any job.
— Printer-friendly estimate previews can be printed for any job.
— Change orders can be viewed, added, and deleted.
— A job’s production status, billing status, status notes, next steps, traffic
assignments, and milestones can be updated from the Traffic web page.
— Web users can view the task’s billings, POs, and job costs.
— The Job Snapshot web page shows authorized users a job’s estimate
remaining, hours worked to date, billings, and profit so far.
— Jobs can be found by client, job name, project, etc.

Production and TrafficProduction and TrafficProduction and TrafficProduction and TrafficProduction and Traffic

— The shop's Daily Job Status report can be viewed by production status or
billing, just like the regular report printed from Clients & Profits. Users with
the appropriate access privileges can update a job's status codes and status
notes any time.
— The web-based Weekly Traffic report looks like the report printed from
Clients & Profits.
— Creatives and production staff can review the week's deadlines from job
schedules in their Weekly Task Planner web page any time.
— The web-based Work To Do page lets creative and production staff keep
track of unfinished job tasks for any range of start dates or due dates.
— The Daily Job Status and Weekly Traffic reports can now show jobs by
billing status.
— Both clients and staff members can use the web-based Client Job Status
report to track a client’s open jobs.
— The Job Timeline can be viewed for one job at a time.— The Job Timeline can be viewed for one job at a time.— The Job Timeline can be viewed for one job at a time.— The Job Timeline can be viewed for one job at a time.— The Job Timeline can be viewed for one job at a time.
— Opened jobs can be tracked using the Production Planner.— Opened jobs can be tracked using the Production Planner.— Opened jobs can be tracked using the Production Planner.— Opened jobs can be tracked using the Production Planner.— Opened jobs can be tracked using the Production Planner.

Job CostingJob CostingJob CostingJob CostingJob Costing

— Production, creative, and account service staffers can find and review
purchase orders, broadcast orders, and print insertion orders.
— Production managers can approve new purchase orders online. Not
available for Clients & Profits Classic users.
— Staff members can enter their hours worked on a daily Time Card web
page.
— Lookup lists on time cards are interactive; clicking on a job or task copies
it to the time card automatically.
— Clients & Profits' budget alerts can now be triggered in My C&P! in POs,
time, and expenses.
— Purchase orders can now be added from My Clients & Profits!
— Time cards have a stopwatch timer to automatically track hours worked.
— Time cards have a "show my tasks" link that lists the user's unfinished
jobs and tasks.
— Users with the right access privileges can approve/unapprove POs.

My Clients & Profits! 5 Features

— Time from previous days can be reviewed and changed as needed, based
on the user’s access privileges.
— Production and creative staff working on location can enter time each
day, keep productivity and job cost reports up-to-the-minute accurate and
timely.
— Staff members can enter daily expense reports for travel, parking, in-
house supplies, and more without manual expense forms.
— Expenses for internal charge items such as CD duplication, output, slides,
and more without rekeying. Not available to C&P Classic users.

Administration and securityAdministration and securityAdministration and securityAdministration and securityAdministration and security

— A Web Server Status window constantly monitors the web server’s
current activity and its connected users (by IP address), producing a hits-
per-hour graph. This window makes it easy for webmasters to check the
server’s performance at a glance.
— My Clients & Profits! will automatically close then reopen the database
at selected times to accommodate the nightly backups.
— The My C&P! web server can be configured as a service under Windows
2000/XP.
— The web server port 80 can be user-defined in Preferences.
— Cookies are used to automatically log in users throughout the day.
— The My Clients & Profits! can be set to automatically start listening for
hits every time the application is opened.
— My Clients & Profits! supports multiple webmasters.
— Webmasters can monitor and manage the My C&P! server remotely from
home or on the road from any internet connection.
— A My C&P! webmaster can be notified automatically via e-mail on failed
attempted log-ins and invalid passwords.
— New user accounts can be created remotely from a web browser.
— The server’s activity log can be printed remotely from a web browser.
— Temporary “guest” access is not allowed to prevent access to My C&P!
from anonymous web users.
— Web accounts can be automatically created for current Clients & Profits
users, eliminating rekeying.
— Users cannot create their own web accounts, and cannot choose their
own passwords (which are required); both are performed by the webmaster.
— User-based web-only access privileges enhance the standard privileges
built into Clients & Profits.
— Web accounts can be temporarily suspended for security reasons.
— A web account is automatically suspended after 3 bad login attempts.
— A detailed activity log keeps track of every kind of hit to the My C&P!
web server, including each hit’s date, time, user ID, IP address, and event/
action.
— The web log can be automatically archived to a text file every Monday.
— Server reports can be printed to analyze the performance and utilization
of My Clients & Profits! based on log entries.
— Your company’s logo can appear at the top of each web page by simply
replacing the my_logo.gif graphic with your own 175x58 pixel graphic.
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Installing My Clients & Profits! on
Windows

The My Clients & Profits! software installs like the regular Clients & Profits
software—simply insert the CD then follow the prompts. My Clients &
Profits! uses a special web-enabled version of the C&P Player. The My
Clients & Profits! web server won’t run with standard versions of the C&P
Player. There is no client-side software to install and nothing to set in the
web browser. Once installed, anyone using Internet Explorer (any version),
Netscape Navigator, or any other browser can start using My Clients &
Profits! immediately.

Preparing the server for My Clients & Profits!Preparing the server for My Clients & Profits!Preparing the server for My Clients & Profits!Preparing the server for My Clients & Profits!Preparing the server for My Clients & Profits!

My Clients & Profits! requires a Pentium 4 PC (1.6 ghz or faster) running
Windows 98/NT/2000/XP with 128mb of RAM, 15mb of free disk space, an
internet connection with a fixed IP address, and an Ethernet connection to
file server that contains the Clients & Profits database. Windows XP Home
is ideal for small web servers that support up to 10 concurrent users. Sites
with higher volumes should use Windows 2000 or Windows XP Profes-
sional. Also, my Clients & Profits! can run as a “service” on Windows 2000/
XP (see page 36).

�  My Clients & Profits! is a self-contained HTTP server, so no extra
software is required. It does not need “server” or “enterprise” versions of
Windows 2000 or Windows XP to operate. My C&P! needs only “worksta-
tion” versions of Windows.

�  The PC should be dedicated to running My Clients & Profits! and notnotnotnotnot
shared with other web, mail, or file servers.

�  To prevent performance problems, do notdo notdo notdo notdo not run My Clients & Profits! on
the same server that also stores the Clients & Profits database.

The web server PC should have a permanent network connection to the
Clients & Profits file server. The shop’s C&P database will be opened
automatically whenever the My Clients & Profits application is started. If
the C&P database is not available, My Clients & Profits! won’t run.

The web server PC must have a fixed IP addressfixed IP addressfixed IP addressfixed IP addressfixed IP address that is accessible both
inside and outside the office. The server PC should be accessible with a
URL (e.g., my.yourdomainname.com). Users will use My C&P! by entering
this URL. Contact your ISP to establish a URL for the My C&P! web server.

To install the My Clients & Profits! softwareTo install the My Clients & Profits! softwareTo install the My Clients & Profits! softwareTo install the My Clients & Profits! softwareTo install the My Clients & Profits! software

�  Before installing My Clients & Profits!, be sure that the computer does
not contain any prior versions of Clients & Profits. Different versions of C&P
can conflict with the My C&P! web server and cause system problems.

11111 Insert the My Clients & Profits! CD-ROM into your computer.

The Windows installer will start up automatically.

Installing My Clients & Profits! on Windows

22222  Click on the Install Software option when prompted.

The Installer will prompt you to choose a destination for the new My C&P
folder. The top level of your C: drive is chosen automatically, but any drive
can be chosen.

33333  Follow the prompts to finish the installation.

A My Clients & Profits! folder will be copied to your hard disk. Inside it
you’ll find a special web-enabled version of the C&P Player, the My Clients
& Profits! application (named My Clients & Profits! 5.0.lbr), an HTML folder
that contains the My C&P! web pages, and other program files.

44444  Restart the computer.

Once the software is installed, My Clients & Profits! needs to be configured.

To start the My Clients & Profits! web server applicationTo start the My Clients & Profits! web server applicationTo start the My Clients & Profits! web server applicationTo start the My Clients & Profits! web server applicationTo start the My Clients & Profits! web server application

11111  Choose Start > Programs > My Clients & Profits!

My C&P! is not a plug-in application, so can’t be run together with Clients
& Profits; it must be run as a stand-alone application. The first time My
Clients & Profits! is started, you will be prompted to serialize the C&P
Player.

22222  Enter your name, company, and current Clients & Profits serial number
(the same one you use for Clients & Profits), then click OK.

33333  Find and open your Clients & Profits database from the file server.

44444  Enter your Clients & Profits user ID and password when prompted.

You must be a regular Clients & Profits user to start the My Clients &
Profits! web server.  Once the web server is opened, access to it by other
users is controlled by a separate web user list (see page 18). You’ll then see
the My C&P! Web Server Status window.  Before the web server can be
started, the server’s preferences and users must be entered.

�  My Clients & Profits! can only access and serve one database at a time.
If your shop uses multiple databases that need to be web-accessible, you’ll
need separate web servers with unique fixed IP addresses for each
database.
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EXTERNAL The External folder contains
software extensions used by the Clients &
Profits Player.

FONTS The Fonts folder contains backup
copies of the cross-platform fonts used by
My Clients & Profits! These fonts are
automatically copied to the Windows
system folder when My Clients & Profits!
is installed.

HTML  The HTML folder contains the web
pages and graphics served by My Clients
& Profits!

LANG_LEX  The Lang_lex folder contains
the files used by the Clients & Profits spell
checker. The spell checker is only used in
the My C&P! application; it doesn’t spell
check web pages.

PREFS The Prefs folder stores a text file
containing the web server’s MIME types,
which tell My C&P! how to serve different
types of web files.

USER_LEX The User_lex folder contains a
custom spelling dictionary.

C&P Player The C&P Player is the
“engine” that runs the My Clients &
Profits! application. This version is web-
enabled, which allows the C&P database
to be shared via HTTP.

cp_pics The cp_pics.DF1 file contains the
graphics used in the My C&P!
application’s window toolbar buttons.

irunin.dat, irunin, irunin.lng  These files
are used by the installer application.

My C&P! 5 user guide  This Acrobat file is
a two-page introduction to the My Clients
& Profits web server designed for users.

My Clients & Profits! 5.0  This is the My
Clients & Profits! web server application.
It is opened and run by the C&P Player to
provide web access to your Clients &

Profits database.

DGDSC32.dll, PSAPI.dll, Omni2ui.dll
These are system files used by the C&P
Player.

Ospell.cfg  This is a system file used by
the built-in spell checker.

WESHARE.dll  The WESHARE file is a
system file used in part to web-enable the
C&P Player.

MYSERV  These files are used by
Windows 2000/XP to automatically open
My Clients & Profits as a service (see page
37).

Inside the My C&P! for Windows Folder

Inside the My Clients & Profits! for Windows folder
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Installing My Clients & Profits! on
a Macintosh

The My Clients & Profits! software installs like the regular Clients & Profits
software—simply insert the CD then follow the prompts. My Clients &
Profits! uses a special web-enabled version of the C&P Player. The My
Clients & Profits! web server won’t run with standard versions of the C&P
Player.

The My Clients & Profits! web server is self-contained; there is no client-
side software to install and nothing to set in the web browser. Once
installed, anyone using Netscape Navigator or Internet Explorer can start
using My Clients & Profits! immediately.

Preparing the Mac server for My Clients & Profits!Preparing the Mac server for My Clients & Profits!Preparing the Mac server for My Clients & Profits!Preparing the Mac server for My Clients & Profits!Preparing the Mac server for My Clients & Profits!

My Clients & Profits! requires a Power Mac, iMac, or eMac (600mhz or
faster) running Mac OS 8.6 or later (including Mac OS 9.x and Mac OS X
v10.2 or later), 128 mb of RAM or greater, 15mb of free disk space, an
internet connection with a fixed IP address, and an Ethernet connection to
the file server that contains the Clients & Profits database.

�  My Clients & Profits! runs on Mac OS X as a “classic” application.

�  My Clients & Profits! is a self-contained HTTP server, so no extra
software is required. It does not need AppleShare, Personal Web Sharing, or
other system software to operate.

�  The Mac should be dedicated to running My Clients & Profits! and notnotnotnotnot
shared with other web, mail, or file servers.

�  To prevent performance problems, do not do not do not do not do not run My Clients & Profits! on
the same server that also stores the Clients & Profits database.

The web server Mac should have a permanent network connection to the
Clients & Profits file server. The shop’s C&P database will be opened
automatically whenever the My Clients & Profits application is started. If
the C&P database is not available, My Clients & Profits! won’t run.

The web server PC must have a fixed IP address that is accessible both
inside and outside the office. The server PC should be accessible with a
URL (e.g., my.yourdomainname.com). Users will use My C&P! by entering
this URL. Contact your ISP to establish a URL for the My C&P! web server.

To install the My Clients & Profits! softwareTo install the My Clients & Profits! softwareTo install the My Clients & Profits! softwareTo install the My Clients & Profits! softwareTo install the My Clients & Profits! software

�  Before installing My Clients & Profits!, be sure that the computer does
not contain any prior versions of Clients & Profits. Different versions of C&P
can conflict with the My C&P! web server and cause system problems.

11111  Insert the My Clients & Profits! CD-ROM into your computer.

22222  Double-click on the My C&P! installer.

Installing My Clients & Profits! on a Macintosh

The Installer will prompt you to choose a destination for the new My C&P
folder. The top level of your hard drive is chosen automatically, but any
volume can be chosen.

33333  Follow the prompts to finish the installation.

A My Clients & Profits! folder will be copied to your hard disk. Inside it
you’ll find a special web-enabled version of the C&P Player, the My Clients
& Profits! application (named My Clients & Profits! 5.0), an HTML folder that
contains the My C&P! web pages, and other program files.

44444  Restart the computer.

Once the software is installed, My Clients & Profits! needs to be configured.

To start the My Clients & Profits! web server applicationTo start the My Clients & Profits! web server applicationTo start the My Clients & Profits! web server applicationTo start the My Clients & Profits! web server applicationTo start the My Clients & Profits! web server application

11111  Double-click on the My Clients & Profits! web server application.

Opening the My Clients & Profits! application automatically launches the
C&P Player. My C&P! is not a plug-in application, so can’t be run together
with Clients & Profits; it must be run as a stand-alone application. The first
time My Clients & Profits! is started, you will be prompted to serialize the
C&P Player.

22222  Enter your name, company, and current Clients & Profits serial number
(the same one you use for Clients & Profits), then click OK.

33333  Find and open your Clients & Profits database from the file server.

44444  Enter your Clients & Profits user ID and password when prompted.

You must be a regular Clients & Profits user to start the My Clients &
Profits! web server.  Once the web server is opened, access to it by other
users is controlled by a separate web user list (see page 18). You’ll then see
the My C&P! Web Server Status window.  Before the web server can be
started, the server’s preferences and users must be entered.

�  My Clients & Profits! can only access and serve one database at a time.
If your shop uses multiple databases that need to be web-accessible, you’ll
need separate web servers with unique fixed IP addresses for each
database.
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Clients & Profits Player X The C&P Player
is the “engine” that runs the My Clients &
Profits! application. This version is web-
enabled, which allows the C&P database
to be shared via HTTP. This version of the
Clients & Profits Player runs on Mac OS 9
and in the “classic” mode on Mac OS
10.2 or later.

My Clients & Profits! 5.0  This is the My
Clients & Profits! web server application.
It is opened and run by the C&P Player to
provide web access to your Clients &
Profits database.

My C&P! 5.0 Admin Guide  This Adobe
Acrobat file contains late-breaking
information about installing, starting, and
running the My Clients & Profits! web
server.

My C&P! 5 user guide  This Acrobat file is
a two-page introduction to the My Clients
& Profits web server designed for users.

HTML  The HTML folder contains the web
pages and graphics served by My Clients
& Profits!

Web Enabled Shared  This file adds the
TCP/IP, HTTP, FTP, and SMTP functions
to the Clients & Profits Player.

USER_LEX The User_lex folder contains a
user’s custom spelling dictionary.

LANG_LEX  The Lang_lex folder contains
the files used by the Clients & Profits spell
checker. The spell checker is only used in
the My C&P! application; it doesn’t spell
check web pages.

Clients & Profits Extensions  The
Extensions folder contains software
extensions used by the Clients & Profits
Player.

PREFS  The Prefs folder stores a text file
containing the web server’s MIME types,

which tell My Clients & Profits! how to
serve different types of web files.

Graph Shared Library  The Graph Shared
Library file is used by the Clients & Profits
Player to draw the web usage graph on the
Server Status window.

Clients & Profits Pics  The cp_pics.DF1
file contains the graphics used in the My
Clients & Profits! application’s window
toolbar buttons.

Inside the My C&P! for Macintosh Folder

Inside the My Clients & Profits! for Macintosh folder
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Setting My C&P! Preferences

Key functions of the My Clients & Profits! web server are controlled by the
system’s preferences, which are user-defined. My C&P! web server
administrators can change these settings and options to improve the
server’s accountability and security. One or more My C&P! users who are
defined as web administrators can change the server’s preferences as
needed, anytime.

�  The server’s preferences can’t
be changed from My C&P! while
the web server is running. If the
server is running, you’ll need to
stop it temporarily while you
make your changes. However,
most preferences can be changed
remotely using a web browser
without stopping the server if the
allow remote administration
setting is enabled.

Remotely managing the My C&P!Remotely managing the My C&P!Remotely managing the My C&P!Remotely managing the My C&P!Remotely managing the My C&P!
web serverweb serverweb serverweb serverweb server

The server’s preferences can be
changed from the My Clients &
Profits! application or remotely
from any web browser. To
remotely change preferences, the
allow remote administration
option must be checked. This
setting allows webmasters to
check and update the server’s
preferences from home, a trade
show, a client’s site—anywhere
there’s an internet connection.

�  There is an inherent security risk to
allowing the My C&P! server’s
preferences to be changed remotely.
While the server’s preferences can only
be changed by a web administrator
(whose user ID and password are assumed
to be private), there’s no guarantee that
someone couldn’t steal the administrator’s
account information and access the server’s settings. For this reason the
server can’t be started or stopped remotely; instead, starting and stopping
My Clients & Profits! can only be done from the application itself.

For better security, remote administration via the internet can be limited to
one specific, preset IP address. The restrict remote administration option
prevents any computer except the one with the preset IP address from
monitoring and managing the My C&P! server remotely. This setting

Setting My C&P! Preferences

Changing My C&P! preferences
anywhere If the allow remote
administration is enabled, web
administrators can change the My
Clients & Profits! web server
preferences from any browser.

ensures that only the designated web administrator’s computer can
remotely manage My Clients & Profits! However, this setting only works for
a computer with a fixed IP address, such as a home computer connected
using a DSL or cable modem. Laptops and computers using a dial-up
modem connection have dynamic IP addresses that change with each new
connection, so they won’t have the same address every time. They can’t be
used for remote administration if the restrict remote administration setting

is enabled.

�  For security reasons, the web
server can’t be started or stopped
remotely.

To change the My Clients & Profits!To change the My Clients & Profits!To change the My Clients & Profits!To change the My Clients & Profits!To change the My Clients & Profits!
web server preferencesweb server preferencesweb server preferencesweb server preferencesweb server preferences

11111  Choose My Clients & Profits! >
Preferences link  from the Web
Server Status window.

The Preferences window opens,
displaying the My Clients & Profits!
web server’s current settings and
options.

22222  Make any changes, then click
Save.

Any changes you make take affect
instantly once the web server is
started.

To change the My C&P! web serverTo change the My C&P! web serverTo change the My C&P! web serverTo change the My C&P! web serverTo change the My C&P! web server
preferences from a web browserpreferences from a web browserpreferences from a web browserpreferences from a web browserpreferences from a web browser

11111  Open your web browser and connect to My Clients & Profits!

22222  Enter your user ID and password, then click Go.

33333  Click the Preferences link in the Web Admin section of your home page.

The web server preferences home page opens, displaying the server’s
current settings and options.

44444  Make any changes, then click Save.



17

1  The always start option tells My C&P!
to check for hits as soon as it’s started. (If
unchecked, My C&P! won’t serve pages
until the web administrator clicks the
“start” button.) The sound bell on hits
option makes My C&P! beep after every
hit. The disable activity log option stops
My C&P! from tracking how people use
the server, which improves performance
by reducing the system’s overhead caused
by logging. The automatically archive
activity log every Monday purges the web
log weekly (see page 25).

2  Use the automatically stop option
accommodate the nightly backup. My
C&P! will stop, close the database, then
reopen the database and restart the web
server at user-defined times.

3  The notify webmasters of failed logins
option e-mails the webmaster every time
someone tries to access My C&P! with an
unknown user ID or password. The disable
web accounts option will suspend any
user who enters an invalid password three
times. The bad password option sends an

The My C&P! Preferences window

The My C&P! Preferences window

e-mail notification when a valid user ID
tries to enter an unknown or incorrect
password.

4  The allow remote administration option
lets web administrators monitor the
server’s status, add web user accounts,
and check the server’s log from any web
browser. If the allow remote administra-
tion option is checked, a web
administrator can be restricted to
accessing the server from a specific
computer at a fixed IP address. To allow a
web admin to access My C&P! anywhere,
leave it blank.

5  The web log server errors tracks TCP/IP
errors on the activity log. The notify
webmaster about server errors option
automatically e-mails the webmaster
about server error. These two settings are
only needed to troubleshoot server
problems.

6  My C&P! uses a javascript based file to
store scripts for displaying data on web
pages. The my_script.js file is normally

accessed from the C&P web site, but can
be served from your own site. For more
information, see page 33.

7  The port number on which My C&P!
listens for hits can be changed from 80,
which is the default for web servers, to
any port number.

8  Enter the name and e-mail address of
the My C&P! webmaster here. Web users
can send questions, problems, and
comments to this webmaster easily from
links included on selected web pages.
While there can be many My C&P! web
administrators, there is only one
designated webmaster. The SMTP server
is either the name or IP address of your
mail server. If you don’t want to get
automatic e-mail, leave it blank.

9  This standard greeting appears on the
introduce page whenever someone tries to
access My Clients & Profits!

10  The table font/size setting is HTML
code that formats cells on CGI-generated
tables, such as a list of job tasks.
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Setting up My C&P! Users

Only authorized My Clients & Profits! web users can access the shop’s
database. Any staff member, freelancer, client, or vendor can be set up as a
My C&P! user—all they need is a valid web account, ID, and password.

All current Clients & Profits users can also be web users, allowing them to
work with clients, jobs, time, and more from either their Clients & Profits
application or the My C&P! web server. Select clients can have their own
My C&P! web account, letting
them see their own jobs,
costs, and job status (but not
for other clients, of course).
Vendors can be allowed to
see their purchase orders.
Also, freelancers can access
their jobs, tasks, and
deadlines. All accounts can
be given expiration dates to
keep users from accessing My
C&P! after a certain date.
There is no guest access to
My C&P!

Web users cannot create their
own accounts online; instead,
accounts can only be created
by a My C&P! web adminis-
trator. Web accounts can be
added from the My C&P! server
application or remotely from a
web browser if the remote
administration preference is
enabled (see pages 16-17).

To view a list of My C&P! usersTo view a list of My C&P! usersTo view a list of My C&P! usersTo view a list of My C&P! usersTo view a list of My C&P! users

11111  Choose Setup > Users, Access & Passwords or click the users users users users users button
from the Server Status window.

The Users window opens, displaying the web accounts for existing My C&P!
users. Since web accounts are not created automatically when My C&P! is
first installed, the list will be empty.

To automatically create web accounts for current C&P usersTo automatically create web accounts for current C&P usersTo automatically create web accounts for current C&P usersTo automatically create web accounts for current C&P usersTo automatically create web accounts for current C&P users

11111  Choose Edit > Auto-create Web Users or click the auto-createauto-createauto-createauto-createauto-create button.

The Auto-create Web Users window lists the shop’s current Clients &
Profits staff members who aren’t already My C&P! users. Some or all
staffers can be given access by clicking on individual user names.

Setting up My C&P! users

Create web accounts automatically The Auto-
create window is a shortcut for creating My C&P!
web accounts for one or more existing Clients &
Profits users. The window lists all current C&P
users who don’t have access to My Clients &
Profits! Clicking the checkbox automatically
creates a web account for the selected users.

22222  Click on the checkbox to create a My C&P! web account for any user,
then click Save.

A new My C&P! web account will be created automatically for each Clients
& Profits selected user. The user’s Clients & Profits information is copied to
My C&P! automatically, so there’s no rekeying of their ID, name, and access
privileges—except for their web password.

Passwords are required to
access the web server. For
better security, users can’t
choose their own passwords;
they can only be changed by
the web administrator. All new
user accounts are given the
temporary password of temptemptemptemptemp.
New My C&P! users will enter
their initials and the password
“temp” until a web administra-
tor assigns a permanent web
password to each new user. To
automatically create a random
password, click the Create
Password button.

To add a new web userTo add a new web userTo add a new web userTo add a new web userTo add a new web user

11111  Choose Edit > Add New Web User or click the add add add add add button.

22222  Enter the web user’s account information and access privileges (see page
20).

33333  Click Save.

To edit a web user’s access privilegesTo edit a web user’s access privilegesTo edit a web user’s access privilegesTo edit a web user’s access privilegesTo edit a web user’s access privileges

11111  From the Users window, double-click on a web user.

22222  Make your changes then click Save.

To delete a web user’s accountTo delete a web user’s accountTo delete a web user’s accountTo delete a web user’s accountTo delete a web user’s account

11111  From the Users window, click once on a web user.

22222  Choose Edit > Delete Web User or click the delete delete delete delete delete button.
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1  Web user accounts can be added,
edited, deleted, and printed by clicking
these toolbar buttons. Clicking a button is
identical to choosing an Edit menu
command.

2  The auto-create button is a shortcut
that creates My C&P! web user accounts
for one or more existing Clients & Profits
users. Clicking this button opens the
Auto-Create window, which lists everyone
who already uses Clients & Profits. If
selected, the account information for each
user will be copied to a new My C&P! web
user account automatically, including
access privileges. Each new user account
is given the temporary web password of
“temp”.

3  To jump to a web user’s access
privileges window, enter the user’s initials
then click the Find button.

The My Clients & Profits! Users window

The My C&P! Users window
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4  My Clients & Profits! allows different
kinds of users to access the shop’s C&P
database, including staff members,
freelancers, clients, and vendors. Each
web user is identified as a staffer,
freelancer, client, or vendor. Since each
individual web user has his or her own
account, the My C&P! user list can
become very long. The show menu filters
the user list to display only one kind of
user at a time, making it easier to track
who can use My Clients & Profits! Choose
“all” to display all web users.

5  The user ID and name identify each My
C&P! web user. Each web user needs a
unique ID, such as initials, before he or
she can access My Clients & Profits!
Existing Clients & Profits users are
identified by the same initials they use in
the C&P database.

6  Click the access privileges button to
edit a web user’s access privileges. These
privileges determine just what someone
can see and do with My Clients & Profits!

7  The user list displays all or some of the
My Clients & Profits! web users. It can
contain names of staff members,
freelancers, clients, or vendors. Double-
click on a user to edit his or her access
privileges.

w

y
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1  Each web user must have a unique ID.
The ID will be used for the user to log
onto My Clients & Profits! if the web user
is also a Clients & Profits user, then the
web ID is identical to their C&P ID (which
is usually their initials). The ID field is
limited to 10 characters, so a long value
like an e-mail address can’t be used as an
ID.

2  Each My C&P! user is identified by
kind—staffer, freelancer, client, or vendor.
This setting determines which pages are
available to users. Clients have their own

My C&P! Access Privileges
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custom home page, and are limited to
seeing only their jobs. Vendors can only
see their POs. Freelancers have limited
access to jobs and traffic.

3  Any account with the web server
administator option enabled can start,
stop, monitor, and manage the My C&P!
web server. The web server administrator
also typically Clients & Profits system
managers. There can be multiple web
administators.

w
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4  The web user’s password is assigned by
the web administrator. For better security,
users can’t choose their own passwords —
or change them later. A user password is
required. Click the Create Password link to
automatically assign a random password.
The password will be automatically
encrypted when the user’s access
privileges are saved. The user’s password
can be set to expire, preventing access to
the My Clients & Profits! server after a
specified date (which is a useful option for
temporary staff).

a
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My C&P! Access Privileges

My C&P! Access Privileges

5  The no web access after option
prevents a web user from accessing My
C&P! after a selected date. Use this for
temporary employees or contractors who
should only use My C&P! for a limited
time.

6  The web administrator can use the
account suspended option to temporarily
prevent a web user from using My C&P! A
user’s web account is automatically
suspended after 3 bad login attempts if
the disable web accounts after failed
logins setting in Preferences is checked
(see page 17).

7 The welcome message is an optional
greeting that appears on each user’s home
page.

8  The allow web access to settings
determine which pages a web user can
see and use. These settings only allow a
user to see a page; what they can or can’t
do with it is based on their access
privileges in Clients & Profits (e.g., adding
job tasks, a PO limit, seeing costs, etc.).

Selecting the clients option allows a web
user to see the client’s account
information as well as client contacts,
billing information. The job tickets access
privileges determine which production,
estimating, and traffic functions are
available to a My Clients & Profits! web
user. If a My C&P! user is a staff member,
then his or her access privileges to jobs is

copied here. Web users who are clients
have no automatic access to jobs; instead,
the web administrator needs to
specifically decide which functions the
user can see by checking on the various
options.

9  Click the All button to make all of the
options available to the web user.

10  Web users can be restricted to seeing
one particular client and its jobs or vendor
and its POs using the restricted to option.
When a client or vendor number (or code)
is entered here, the web user won’t be
able to see any other client’s and vendor’s
data. This option is required for web users
who are clients or vendors. It can be a
useful option for web users who belong to
exclusive account teams. Client and
vendor numbers are available for quick
reference using the Lookup menu.

11  Each user can have a completely
custom home page (see page 37). When a
custom home page is specified in a user’s
web account, My C&P! displays it instead
of the standard home page whenever that
user logs in. The custom home page
needs to be created first, then selected by
clicking on the Get Page button.
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Running the My C&P! Web Server

Once the My Clients & Profits! server software is installed, web service can
be started immediately. (There is no client-side software to install and
nothing to set in the web browser. Anyone using a web browser can access
My Clients & Profits! immediately.)

There are two steps to starting the My Clients & Profits! web server:  (1)
launch the My C&P! application then (2) start the web server.

The My C&P! server application won’t start
listening for requests, or hits, from web
users until web service has been started.
This gives the web administrator a chance
to update the user list, review the activity
log, and update preferences before web
users start accessing the server.

�  Opening the My Clients & Profits!
application doesn’t automatically start the
web server unless the always start web
service at startup option is enabled in
Preferences. When this option is enabled,
My C&P! will start listening for hits as soon
as the server application opens (for more
information on setting preferences, see
page 16).

�  The My Clients & Profits! web server can
be set to automatically close the database at
a specified time each evening to accomodate the nightly backup. The web
server will stop listening for hits, but doesn’t actually shut down. Instead,
My C&P! waits until a specified time then reopens the database and
restarts the server. Clicking the automatically stop My C&P! for nightly
backups preference sets the close and reopen time to 11 pm and 5 am.  The
close time can’t be set before 5:00 pm or after 12:00am. The reopen time
can’t be set after 12:00 am or before 10:00 am.

To start the web serviceTo start the web serviceTo start the web serviceTo start the web serviceTo start the web service

11111  Choose My Clients & Profits > Start Web Server or click the start start start start start button.

Starting the web service resets the Web Server Status window: the Today’s
Activity list, the Connected User list, and the Hits Per Hour graph. As soon
as web users start logging onto My Clients & Profits! you’ll see the hits
reflected on this window.

The Web Server Status window usually remains open while My Clients &
Profits! is running, making it easy for web administrators to monitor the
server’s usage and performance at a glance.

Running the My Clients & Profits! Web Server

The main menu All of the key
functions of My C&P! are
available from the main menu.

To stop the web serviceTo stop the web serviceTo stop the web serviceTo stop the web serviceTo stop the web service

11111  Choose My Clients & Profits > Stop Web Server or click the stop stop stop stop stop button.

Stopping the web service stops My Clients & Profits! from listening for hits
from web users.

�  If a web user tries to access My Clients & Profits! when it isn’t running,
they’ll get a “a connection failure has occured” error from their web

browser. It may take up to one minute for the
browser to realize the server’s not running and
show the error message.

Making changes to the My Clients & Profits! webMaking changes to the My Clients & Profits! webMaking changes to the My Clients & Profits! webMaking changes to the My Clients & Profits! webMaking changes to the My Clients & Profits! web
serverserverserverserverserver

The My Clients & Profits! web server doesn’t have
to be stopped to make changes to users,
preferences, or the activity log. All of these
functions can be accessed without interrupting
web service.

To monitor the web server’s statusTo monitor the web server’s statusTo monitor the web server’s statusTo monitor the web server’s statusTo monitor the web server’s status

If the My C&P! Web Server Status window isn’t opened, choose My Clients
& Profits! > Web Server Status. The Server Status window displays the
server’s recent activity and connected users.

�  The My C&P! web server can also be monitored remotely from a web
browser if the allow remote administration preference is enabled. This
setting allows a web administrator to view the server status, activity log,
user list, and preferences web pages from any internet connection.

To reset the My Clients & Profits! web serverTo reset the My Clients & Profits! web serverTo reset the My Clients & Profits! web serverTo reset the My Clients & Profits! web serverTo reset the My Clients & Profits! web server

Resetting the My C&P! server clears the Today’s Activities list, Connected
Users list, and Hits-Per-Hour graph. It does not stop the web server or affect
whatever work a connected user is doing. Starting the web server
automatically resets the server’s stats. My C&P! only needs to be manually
reset each morning so that the Server Status stats are cleared for the new
day’s work—and only if My C&P! wasn’t stopped the night before.

Looking up clients, vendors, staff members, etc.Looking up clients, vendors, staff members, etc.Looking up clients, vendors, staff members, etc.Looking up clients, vendors, staff members, etc.Looking up clients, vendors, staff members, etc.

For easy reference, lookup lists for clients, jobs, vendors, staff members,
and more can be opened by the web administrator from the My Clients &
Profits! application using the Lookup menu.

To quit My Clients & Profits!To quit My Clients & Profits!To quit My Clients & Profits!To quit My Clients & Profits!To quit My Clients & Profits!

1  Choose File > Quit.
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1  The start and stop buttons control the
My Clients & Profits! web server. Clicking
the Start button tells My C&P! to begin
listening for requests, or hits. Clicking the
Stop button stops the server, but leaves
the My C&P! application running.

2  Clicking the users button opens the My
C&P! users window, where web user
accounts can be added, edited, and
deleted.

3  Click the prefs button to change the My
Clients & Profits! web server’s
preferences.

4  Clicking the log button opens the My
Clients & Profits! activity log.

5  Click the print button to print web
server performance and utilization reports.

6  Clicking the reset button clears the
data on the Web Server Status window,

including the day’s activities, currently
connected users, and hits-per-hour graph.
Use the Reset function to start a new set
of daily statistics.

7  The database name shows the name
and location (i.e., file server) of the Clients
& Profits database which is being served
by My Clients & Profits!

8  The web server’s current status tells
you what the My Clients & Profits! system
is doing right now.  The typical status is
“Running” while it waits for requests from
web users.

9  The today’s activity list displays the
day’s most recent hits to the web server.
Hits, or requests from users, are listed
chronologically, newest ones first. Each hit
shows its date and time, the web user who
made the request, and what action
occured. This list can get very long.

Clicking the Clear button erases the list
without actually deleting the log entries.

10  The connected users list shows the
names of recent web users. The list
displays the most-recent My C&P! users
first. Users are identified by IP address. A
specific user can be disconnected from
My C&P! by clicking the disconnect user
button, which allows a different user to
connect to web server with the same IP
address.

11  The hits per hour graph visually shows
how busy the web server has been today.
The graph charts hits per hour from 6 AM
to 8 PM (hits after those hours aren’t
graphed). The graph’s scale will change
based on the volume of hits to the web
server.

12  The current event panel shows the
process currently being performed by the
web server.

The My C&P! Web Server Status window

The My C&P! Web Server Status window
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The My C&P! Activity Log

The activity log keeps track of every request, or hit, to the My Clients &
Profits! web server. Each hit creates a web log entry, which contains the
date and time of the hit, the user’s ID, and what actually happened (i.e., the
event).

The activity log can store thousands of hits. Log entries are created
instantly after every hit to the web server. The activity log can be searched
to find entries for a
particular day, which can
then be printed.  The
web log can be
automatically archived
every Monday based on
a setting in Preferences
to keep the log size
manageable.

Webmasters can view
the log any time from
the My Clients & Profits!
server application to
monitor the server’s
work load. The log can
also be monitored from a
web browser if the allow
remote administration
option is enabled in
Preferences (see pages
16-17).

To view the My C&P!To view the My C&P!To view the My C&P!To view the My C&P!To view the My C&P!
activity logactivity logactivity logactivity logactivity log

11111  Choose My Clients &
Profits! > Activity Log or
click the log log log log log button
from the Server Status
window.

The Activity Log window opens, list-
ing all of the web server’s log entries
in chronological order. The entries on
the log can be sorted by date, user,
and event description by clicking on
a column heading. The sort direction (i.e., ascending or descending) can
be changed by clicking on the up and down buttons.

To find a selected day’s log entriesTo find a selected day’s log entriesTo find a selected day’s log entriesTo find a selected day’s log entriesTo find a selected day’s log entries

11111  Enter a date into the find date:find date:find date:find date:find date: field then choose File > Find Log Entries
or click the find find find find find button.

The My C&P! Activity Log

The log entries for the selected date will be highlighted in the Activity Log
window. To print a list of these log entries, click the print print print print print button.

To print the activity logTo print the activity logTo print the activity logTo print the activity logTo print the activity log

The Activity Log Report is a hard-copy version of the activity log window.
The printed report shows all log entries or some entries, depending on

which ones are selected.
Log entries will be
sorted on the printed
report in the same way
they are sorted on the
window.

To print the entire
activity log, choose Edit
> Deselect Log Entries.
To print a selection of
log entries, use your
mouse to highlight the
entries you wish to
print.

11111  Choose File > Print
Activity Log or click the
print print print print print button.

To clear the activity logTo clear the activity logTo clear the activity logTo clear the activity logTo clear the activity log

Selected entries can be
removed from the
activity log. While the
activity log can hold
over 100,000 entries,
the number of entries
that are displayed in the
Activity Log window is

based on your computer’s available memory. Log entries should be
regularly deleted when they are no longer relevant or likely to be used.

To clear a selection of log entries, use your mouse to highlight a set of
entries. To clear the entire list, choose Edit > Deselect Log Entries.

11111  Choose Edit > Clear Log Entries or click the clear clear clear clear clear button.

To export log entriesTo export log entriesTo export log entriesTo export log entriesTo export log entries

Selected entries can be exported from the activity log into a tab-delimited
text file. This text file can then be opened by Microsoft Excel, FileMaker
Pro, Access, and any other spreadsheet or database for analysis. Exporting

Sorting the activity log  Log entries for
every hit to the My Clients & Profits!
server is recorded in the Activity Log. Log
entries can be sorted by date, user, or by
what  appened by clicking when, user, or
event column headings.
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A web-based activity log  The My
Clients & Profits! server activity log
can be monitored from any internet
connection using any web browser if the
allow remote administration preference is
enabled. This option lets web
administrators track the server’s usage

is an ideal method for storing old sets of log entries when they are no
longer needed in the activity log.

�  Exporting doesn’t clear log entries. If you don’t want to keep exported
entries in the activity log, click the Clear button to delete the selected log
entries.

To export a selection of log
entries, use your mouse to
highlight a set of entries. To
export the entire list, choose
Edit > Export Log Entries.

11111  Choose Edit > Export Log
Entries or click the exportexportexportexportexport
button.

To remotely monitor the activityTo remotely monitor the activityTo remotely monitor the activityTo remotely monitor the activityTo remotely monitor the activity
logloglogloglog

The My Clients & Profits! web
server activity log can be
monitored remotely from any
internet connection using a web
browser. This ability lets My
C&P! web administrators
monitor the server’s usage and
performance when they’re
outside the office—from home,
an airport, a trade show, or a
client’s office.

The allow remote administration
option in the My C&P! web
server’s preferences must be
checked before the log can
accessed from a browser.
The view activity log function
appears as a link on the web
administrator’s home page.

�  Only web administrators can
remotely monitor and manage the
My Clients & Profits! server from a
web browser.

To automatically archive the webTo automatically archive the webTo automatically archive the webTo automatically archive the webTo automatically archive the web
log every Mondaylog every Mondaylog every Mondaylog every Mondaylog every Monday

The automatically archive activity log every Monday option tells My Clients
& Profits! to export the week's web log every Monday morning, then start a

brand-new log for the week. This setting keeps your web log's size
manageable (a busy shop with lots of web users could have a 10,000+ entry
web log within months). The exported logs are automatically dated and
stored in the same folder as your My C&P! web server.

These tab-delimited text files can be opened in Excel, FileMaker, Access, or
any text editor. To keep all of the web log entries together in your

database, leave this
preference unchecked.

11111  Choose Setup >
Preferences.

22222  Check the
automatically archive
activity log every
Monday option.

33333  Click Save.
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Printing My C&P! Server Reports

Server reports are your best source of up-to-date statistics on the My
Clients & Profits! web server’s usage. These reports analyze the My C&P!
activity log to determine the most-active users, most-popular web pages,
and more. Web server reports can be printed for any range of dates, letting
web administrators compare the server’s performance and utilization for
any period of time.

General General General General General reports are lists of users
and other basic information
about the My Clients & Profits!
server. These reports provide
hard-copy printouts of staff
members, freelancers, clients,
and vendors and what they can
do with My Clients & Profits!

Performance Performance Performance Performance Performance reports look at the
big picture—raw numbers of hits
by days of the week, time of day,
and week vs. week. These reports
help web administrators track
the busiest times for My Clients
& Profits!, which helps them
better manage the system. The
“hits” report series can be
printed for one day, one week, or
any time period. This flexibility
allows web administrators to see
more or less data on reports.

Utilization Utilization Utilization Utilization Utilization reports highlight the
most and least active users, as well
as the most- and least-used web
pages. These reports help web
administrators determine which
parts of My Clients & Profits! are
useful and productive to staff members, freelancers, clients, and vendors.

�  Each of the server reports has its own unique purpose. You may not need
everyone to help web administrators manage the server. Instead of printing
every report, experiment with each report (and its various options) to see
which one gives web administators the best information they need to stay
on top of the server’s performance.

To print server reports

Most of the web server reports are based on entries in the activity log,
which are selected for a range of dates. Entering a range of dates will
search the log and analyze the entries for that time period.

Who’s using what?  My Clients & Profits!
reports analyze how the server is being
used for a day, week, month, quarter, or
any period of time based on entries saved
in the server’s activity log.

1 1 1 1 1  Choose File > Print Server Reports, or click the print print print print print from the Web Server
Status window.

22222  Select the kind of report you wish to print (e.g., General, Performance, or
Utilization).

3 3 3 3 3  Make your report selections.

4 4 4 4 4  Click Print.

Server reports that show a broad
time period, such as a month or
quarter, will take longer to print
than reports based on a day or
week, since there are more log
entries to analyze.

Tips for printing My C&P!
server reports

� Use the Peak UsagePeak UsagePeak UsagePeak UsagePeak Usage report to
keep track of the My Clients &
Profits! web server’s busiest times.
Web administrators can use this
analysis to better plan maintenance
and other downtime, and well as
determine whether the server
hardware is adequately handling the
work load.

�       Since web users can’t choose or change their own passwords, it’s up to
the web administrator to maintain them. The Account/Password ExpirationAccount/Password ExpirationAccount/Password ExpirationAccount/Password ExpirationAccount/Password Expiration
report lists accounts and passwords that are emiently expiring within the
next 30 days and need attention. If the web administration doesn’t update
these expiration dates, the web users will suddenly lose access to My
Clients & Profits! This report should be printed monthly.
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My Clients & Profits! Server Reports

Web Users - Staff Members

Web Users - Freelancers

Web Users - Clients

Web Users - Vendors

Account/Password Expirations

Hits by Day

Hits by Time

Hits by Week

Peak Usage

Errors

Most-Active Users

Least-Active Users

Most-Popular Pages

Least-Popular Pages

User Connections

The Web Users report lists staff members by user ID. This report shows each user’s last access
date and other account information.

This version of the Web Users report shows only users marked as “freelancers” in the Users list.
Freelancer users can have the same access privileges as staff members.

This version of the Web Users report only shows individuals who work for the shop’s clients,
displaying each user’s account information. Users are grouped by client number.

This version of the Web Users report displays web users who work for the shop’s vendors.

The Account/Password Expiration report lists expiring web accounts. The report has two parts:
one for expiring accounts and another for expiring passwords. Since users can’t change
passwords themselves, web administrators can use this report to update old passwords.

The Hits by Day report analyzes users requests, or hits, for each day of a selected week. This
report calculates the total hits per day to help web administrators track the server’s volume.

The Hits by Time report analyzes how web users used My Clients & Profits! throughout the day.
The report totals up hits by hour for any range of dates.

The Hits by Week report compares hits to the My Clients & Profits! web server week-by-week for
any selected period of time. The report helps analyze My C&P! usage over a longer time frame.

The Peak Usage report calculates the web server’s busiest times based on the number of hits
per hour for a range of dates.

The Errors report analyzes the web server’s activity log for error log entries. Web administrators
can use this report to monitor the number, frequency, and type of errors occuring in My C&P!

The Most-Activity report displays the users with the most connections to the My C&P! server.

The Least-Activity report displays web users who have the fewest connections to the server.

The Most-Popular report analyzes the activity log for the most frequently used web pages.

The Least-Popular report displays pages with the least number of hits from web users.

The User Connections report lists connections to the My C&P! web server by IP address.

General

Utilization

Performance
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Remotely Managing My C&P!

Parts of the My Clients & Profits! web server can be monitored and
managed remotely from any internet connection using a web browser. This
ability lets My C&P! web administrators monitor the server’s usage and
performance when they’re outside the office—from home, an airport, a
trade show, or a client’s office.

The remote administration functions include server status monitoring,
viewing the activity log, setting
the My C&P! web server’s
preferences, adding new web
users, and updating web user
access privileges. These functions
appear as links on the web
administrator’s home page.
Remote administration has no
affect on regular My C&P! users,
and is completely optional.

�  Only web adminstrators can
remote monitor and manage the
My Clients & Profits! server from a
web browser. Any web user who is
a staff member (i.e., not a client,
freelancer, or vendor) can become
a web administrator by checking
the web server administrator
option in the user’s access
privileges window.

Remote administration is not a
standard option, so must be
enabled in the My C&P!
preferences. Once enabled, any
My C&P! user with web adminis-
trator privileges can connect to
the server, monitor it, and make
changes.

Restricting remote administrationRestricting remote administrationRestricting remote administrationRestricting remote administrationRestricting remote administration

My Clients & Profits! features a special
high-security option to prevent unauthorized people from remotely
monitoring and changing the web server. The restrict remote administration
to IP address option appears when the allow remote administration option
is checked. This security option restricts My Clients & Profits! from being
remotely administered by only one specific computer based on its IP
address. If an IP address is entered here, only the computer that has this
address will be allowed to monitor and manage My Clients & Profits! My
C&P! can still be accessed from any other addresses, but the remote
administration links will not appear on your home page. This setting
effectively restricts My C&P! from being monitored and managed from an

unknown computer—and more than one web administrator, since it allows
for only one IP address. It should be used at sites where security is more of
a concern than easy accessibility by web administrators.

�  This option will only work for computers with fixed IP addresses, such as
the ones on your LAN. It won’t work for web administrators who use a
laptop and a dial-up modem connection to My C&P!, since its IP address

changes with each new connec-
tion.

To enable remote administrationTo enable remote administrationTo enable remote administrationTo enable remote administrationTo enable remote administration

11111  Choose Setup > Preferences.

22222  Click on the allow remote
administration option to select it.

33333  If the restrict option is to be
used, enter the web administrator’s
IP address; otherwise, leave it
blank to allow any web administra-
tor to remotely control My C&P!
from any computer.

44444  Click Save.

Once the allow remote administra-
tion option is selected, a web
administrator can monitor the
server from a browser immediately.

To remotely monitor the server’sTo remotely monitor the server’sTo remotely monitor the server’sTo remotely monitor the server’sTo remotely monitor the server’s
statusstatusstatusstatusstatus

11111  Open your web browser then log
onto My Clients & Profits! with

your user ID and password.

Your customized home page appears, which now includes links for remote
server administration: server status, users, activity log, and preferences.

22222  Click on any admin link to monitor or manage the server.

To monitor the server’s statusTo monitor the server’s statusTo monitor the server’s statusTo monitor the server’s statusTo monitor the server’s status

11111  From the home page, click on the Server Status link.

The server statusserver statusserver statusserver statusserver status link opens the My C&P! Web Server Status page (see
above). This page is the web-page equivalent of the My C&P! Server Status
window. It shows the currently opened database, the server’s current
status, and the date and time the server was started. The page also lists the

Remotely Managing My C&P!

Monitoring the server’s status The My
Clients & Profits! server status web page
shows who is using My C&P! as well as the
day’s hits.
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server’s connected users (listed in order of last access to the server) and
the day’s activities (i.e., log entries).

To view a list of My Clients & Profits! web usersTo view a list of My Clients & Profits! web usersTo view a list of My Clients & Profits! web usersTo view a list of My Clients & Profits! web usersTo view a list of My Clients & Profits! web users

11111  From the home page, click on the Users link.

The users users users users users link opens the My
C&P! Users page, which lists
your web user accounts. User
accounts are listed in
alphabetical order by ID.
Clicking on an account lets
you edit the user’s access
privileges.

To edit a web user’s accessTo edit a web user’s accessTo edit a web user’s accessTo edit a web user’s accessTo edit a web user’s access
privilegesprivilegesprivilegesprivilegesprivileges

11111  From the Users web page,
click on the user’s name.

The user’s access privileges
web page opens. There are
limits to what user account
information can be seen and
changed remotely. For
example, the user’s password
can’t be changed here; for
security reasons, it must be
changed from the My C&P!
application itself.

22222  Make your changes, then
click Save.

The changes take effect
immediately.

To add a new web user accountTo add a new web user accountTo add a new web user accountTo add a new web user accountTo add a new web user account

A new user account can also be
created remotely, which can be
convenient for webmasters who
aren’t always near the My C&P! server.

11111  From the Users web page, click
on the Add New User link.

The user’s access privileges web page opens.

Remotely Managing My C&P!

Monitoring the server’s log The My Clients
& Profits! activity log web page shows all
of the server’s hits in chronological order,
newest ones first. If the log web server
errors preference is enabled, any kind of
TCP/IP error will be logged and displayed
in red. This setting should be used for
troubleshooting only since it generates a
large number of web log entries.

22222  Enter the new web user’s account  information.

33333  Click Save.

The new user can access My Clients & Profits! using their ID and password
immediately.

To view the server’s activity logTo view the server’s activity logTo view the server’s activity logTo view the server’s activity logTo view the server’s activity log

11111  From the home page, click on
the Activity Log link.

The activity logactivity logactivity logactivity logactivity log link opens the
Log web page, which lists the
server’s hits in chronological
order (newest ones first). This
page can take several minutes
to display if the log is large.

To change the web server’sTo change the web server’sTo change the web server’sTo change the web server’sTo change the web server’s
preferencespreferencespreferencespreferencespreferences

11111  From the home page, click on
the Preferences link.

The preferences preferences preferences preferences preferences link opens the
My C&P! preferences web page.
Since preferences can’t be
changed from the My C&P!
application while it’s running,
this web page is the only way to
change preferences without
stopping the server.

The help link at the bottom of
the Preferences page accesses
the online user guide. The user
guide contains step-by-step

instructions for setting up, running, managing, and using the My Clients &
Profits! web server.

22222  Make your changes to the server’s preferences, then click Save.

The changes you make take affect immediately.



30 Customizing My Clients & Profits!

Customizing My Clients & Profits!

The web pages that your My Clients & Profits! users see are customizable.
All of the pages can be redesigned to reflect your shop’s style and image.
Changing a page’s design doesn’t affect its function; it still works the same
way as the standard My C&P! web page. But the look-and-feel of your web
pages can complement your corporate identity so well  that users will think
they’re accessing the company’s web site.

All My Clients & Profits! web pages
share the same general design, which is
intentionally simple. They have a
common banner graphic, header, and
footer, all of which can be customized.
Only the body of each page varies, which
is composed on-the-fly with content
from your Clients & Profits database. The
My C&P! web pages are designed for
easy modification, so they are free of
frames and other complicated design
elements.

Standard web pages vs. database-drivenStandard web pages vs. database-drivenStandard web pages vs. database-drivenStandard web pages vs. database-drivenStandard web pages vs. database-driven
web pagesweb pagesweb pagesweb pagesweb pages

My Clients & Profits! will serve both
standard HTML web pages and dynamic,
database-driven web pages that use data
from the Clients & Profits database. Any
page that’s located in the HTML folder
can be accessed by web users. New
pages can be linked to any page by
editing the home page’s HTML source
code. New data-driven web pages can’t
be added because no My C&P! CGI can
be created by end-users to process them
(however, new CGIs will be provided in
software updates to My C&P!). However,
you can add any number of new HTML
pages to your My C&P! web server.

About OMFLDsAbout OMFLDsAbout OMFLDsAbout OMFLDsAbout OMFLDs

Most of the My C&P! web pages are database-driven, meaning they show
real-time data from the Clients & Profits database. Fields from the database
are displayed on a web page using special formatting tags called “OMFLDs”
(pronounced “Om-Fields”).

OMFLDs contain field names from the Clients & Profits application. OMFLDs
appear on web pages as HTML tags—for example, the job number field is
entered as <OMFLD>J_NUM</OMFLD>. Whenever a page is requested by a
web user, the My C&P! server loads the page’s HTML code then searches for
any OMFLDs contained within it. The OMFLDs tell the My C&P! server just

what data the user is looking for, which is then retrieved from the database
on the file server. My C&P! replaces the page’s OMFLDs with the real-time
data, then sends the newly-composed page back to the user’s web browser.
The entire process takes only seconds.

Some web pages, such as job_ticket.htm, have easily recognizable OMFLDs.
When a My C&P! page is opened in an editor, the data field names for job

tickets are obvious: J_NUM, J_NAME,
J_START_DATE, etc.

�  If you’ve ever created custom reports
in Clients & Profits using the built-in
report writer, these field names should be
familiar; if not, you’ll find definitions for
each data file and field name in the
Clients & Profits Data Dictionary:
www.clientsand profits.com/support/
data_dictionary/data_
dict.html.

In addition, there are several special-
purpose OMFLDs that aren’t in the Data
Dictionary, such as CONTENT, DATE,
LINKS, GREETING, LOOKUP, etc. These
tags are used to compose lists of data,
such as a job’s tasks, as well as forms.

Adding, removing fields from web pagesAdding, removing fields from web pagesAdding, removing fields from web pagesAdding, removing fields from web pagesAdding, removing fields from web pages

Other data fields can be added to web
pages by simply entering the OMFLDs in a web page editor. For example, to
add the job’s “date closed” field to the job_ticket.htm page, add the text
<OMFLD>J_DATE_CLOSED</OMFLD> to the page’s HTML code.

�  Field names must be spelled accurately or else the data from the C&P
database won’t display on the page.

Fields can be removed from a web page by deleting the OMFLD tags
completely from the HTML source code.

Customizing Web PagesCustomizing Web PagesCustomizing Web PagesCustomizing Web PagesCustomizing Web Pages

The My Clients & Profits! system contains over 100 web pages, all of which
can be tailored to your shop’s identity and style. (For a flow chart
illustrating how the web pages are related, see page 40.) The key pages
include:

Introduce YourselfIntroduce YourselfIntroduce YourselfIntroduce YourselfIntroduce Yourself  Introduce.htm is the first page users see when they
access My Clients & Profits! Its only purpose is to log a user onto the My
C&P! server. It functions as the gatekeeper, and is the only way to enter the
My Clients & Profits! web server.

Home page GIFs The clip art used on
the My C&P! home page can be
replaced with your own graphics.
Simply replace the standard GIF with
your own graphic, keeping the same
file name. When the home page is
opened, your graphics will be
displayed.
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Home  Home  Home  Home  Home  The home page is the primary interface for all of My Clients &
Profits! It contains links for all of the functions available to a particular
user, based on a user’s access privileges. There are four separate home
page HTML files, one for each type of My C&P! user: home.htm for staff
members; home_admin.htm for web administrators; home_client.htm for
the shop’s clients; and home_vendor.htm for the shop’s suppliers. These
pages are virtually identical, except that functions which aren’t applicable
to a kind of user are removed (e.g., clients can’t enter time, staff members
can’t add web users, etc.). The same home page is used for both staff
members and freelancers. The web administrator’s home page is identical
to the staffer’s home page, except that it has links to remotely monitor and
manage the web server. The client and vendor home page do not have links
to the company calendar, handbook, forms and have fewer lookup links. All
clients share the same home_client.htm web page, and all vendors share
the same home_vendor.htm web page. While the four home pages look
alike, they can be substantially redesigned for each kind of user.

�  Individual users can have their own custom home pages, which are used
instead of the standard home pages. Custom home pages can be designed
for special needs, such as users who use palm PCs to access My Clients &
Profits! For more information see page 37.

The home page can take several seconds to load because of the graphics.
When a web user clicks on a home page link, the new page always opens in
a new window. This way the home page never closes, so it never has to
reload its graphics. This also helps keep users from becoming lost.

�  When adding new links to the home page, always open the page in a
NEW window so that home page never closes. This saves users time by not
repeatedly reloading the home page).

The home page has 10 sections: a banner, a welcome, links to functions
(e.g., opening jobs, entering time, etc.), lookups, the company calendar,
company news, industry news, general information, an optional company
handbook, and optional company forms as well as a help link and an e-mail
link to the My C&P! webmaster. All of these links, except for functions, can
be expanded or removed as needed. (The function links can’t be changed
because they are composed on-the-fly by the My C&P! server based on the
user’s access privileges). The home page sections include:

Banner: The home page banner identifies the page to users. It has two
parts: the left side is an animation, while the right side is static. This
banner is not linked to any other web page.

Welcome:  The welcome section contains an OMFLD for the user’s greeting,
which is entered by the web administrator in each user account. Since the
greeting is user-based, it allows the home page to be more personalized for
each user. Graphics and text that are common among all users can be
added into this section.

Functions:  The function links (e.g., clients, job tickets, time card, etc.) for
the OMFLDs LINKS1, LINKS2, and LINKS3 are composed on-demand by
the My C&P! server based on the user’s access privileges. Each of the home
page’s functions has its own graphic. The names of these GIFs are hard-

This 468x60 gif is used at the top of almost every page; not linked
This 175x58 gif is used for your company logo at the top of every page
Introduce Yourself page graphic
Used with Company Calendar links; not linked
Animated left section of home page banner; not linked
The right section of the home page banner
Link to Add Job Ticket page
Link to Add Purchase Order page
Link to Add Internal Charges page (C&P Pro users only)
Link to Clients page
Link to Client Job Status page
Link to Add Expenses page
Link to the In/Out Board page
Link to Weekly Traffic Report page
Link to Work To Do page
Used with Links section on home pages; not linked
Used with Company News links on home pages; not linked
Used with Industry News links on home pages; not linked

banner.gif
my_logo.gif
intro_logo.gif
calendar.gif
home_banner_left.gif
home_banner_right.gif
home_button_add_job.gif
home_button_add_POs.gif
home_button_charges.gif
home_button_clients.gif
home_button_client_status.gif
home_button_exp.gif
home_button_in_out.gif
home_button_traffic.gif
home_button_work.gif
link.gif
pencil.gif
thumbs_up.gif

all pages
all pages
introduce.htm
home.htm
home.htm
home.htm
home.htm
home.htm
home.htm
home.htm
home.htm
home.htm
home.htm
home.htm
home.htm
home.htm
home.htm
home.htm

Name Used on Pages Description

Selected My Clients & Profits! Graphics

For a complete list of My C&P! graphics, please see www.clientsandprofits.com/my/my_graphics.html
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Customizing My C&P! (con’t)

coded into the My C&P! server and can’t be changed. However, the graphic
itself can be replaced by your own graphic—as long as it has the same file
name. (See page 31 for a list of graphic file names and how they are used.)

Lookups:  These links open lookup pages that feature lists of clients, jobs,
vendors, staff members, tasks, status codes, and more.

Links: These links are for general information that the company (or the web
administrator) feels would be useful to My Clients & Profits! users.

Company handbook:  The online company handbook is optional, but can be
an effective way to keep staff members up-to-date on company policies
and procedures. No standard handbook is included with My C&P!, so you’ll
have to convert your existing employee handbook to HTML pages first.
Once converted into separate web pages, move your pages into the My
C&P! HTML folder then link them to the handbook section of the home
page. These pages are more confidential than a regular web server, since
only My C&P! users can see them.

Company forms:  Online versions of the company’s forms can be provided
to staff members using My Clients & Profits! No standard forms are
included with My C&P!, so you’ll need to create your own HTML pages or
PDF files. These forms aren’t CGI-enabled, so My C&P! won’t process them
with data from the Clients & Profits database. They are included here only
as an easy way for employees to print copies for their own use.

�  Both the company handbook and company forms sections should be
removed if they are not going to be used.

Clients Clients Clients Clients Clients  The clients.htm page resembles the Clients window in Clients &
Profits, including the links to billing info, contacts, etc. The client account
fields are displayed in a table. Any fields from the client data file can easily
be added to the table by simply typing an OMFLD with a field name. The
client contact, billing info, stats, budget, diary, and projects pages can be
customized in the same way. The client jobs and invoices pages are less
customizable, since their content is composed on-demand by My Clients &
Profits! via CGI.

Job Tickets Job Tickets Job Tickets Job Tickets Job Tickets  The job_ticket.htm page looks identical to the Job Ticket
window in Clients & Profits. The page shows the job number, client, job
name, and other details as well as the job’s tasks. Job tasks are listed via
CGI using the “content” OMFLD, so can’t be modified. The links for Add
Tasks, View Billings, View POs, and View Costs are also displayed via CGI
based on the user’s access privileges, and can’t be changed.

Proposals, Daily Job Status, Traffic, Weekly Task Planner, ProductionProposals, Daily Job Status, Traffic, Weekly Task Planner, ProductionProposals, Daily Job Status, Traffic, Weekly Task Planner, ProductionProposals, Daily Job Status, Traffic, Weekly Task Planner, ProductionProposals, Daily Job Status, Traffic, Weekly Task Planner, Production
Planner, Work To Do, Client Job Status  Planner, Work To Do, Client Job Status  Planner, Work To Do, Client Job Status  Planner, Work To Do, Client Job Status  Planner, Work To Do, Client Job Status  These production and traffic web
pages are composed using CGI-based forms, so the body of these pages
generally can’t be modified. However, new graphics and other elements can
still be easily added.

Purchase Orders Purchase Orders Purchase Orders Purchase Orders Purchase Orders  The purchase_order.htm page resembles Purchase Orders
window in Clients & Profits. The page displays the shop’s purchase,
broadcast, and insertion orders. The order’s line items are displayed in a list
using the “content” OMFLD, which can’t be changed. The page has “next”
and “previous” links to view a different order, as well as a form for finding a
specific order by number. The page has links to the order’s description,
specs, vendor info, and options. A different web page will display
depending on whether the order is a purchase order, broadcast order, or
insertion order.

Time Card Time Card Time Card Time Card Time Card  The time_card.htm page resembles the pop-up Daily Time Card
window in Clients & Profits. The page lists the day’s time entries (in the
OMFLD named “CONTENT”) with “next” and “previous” links to view a
different day’s time. Users can add a time entry using a form at the bottom
of the page. The form has entry fields for job number, task, hours, notes,
and an overtime checkbox. HTML does not support all-cap fields, so the job
number and task code can be entered in lowercase letters. (My C&P! will
convert lower-case letters to capitals automatically when the time entry is
saved.) The form action /save_new_time calls the My C&P! CGI that saves
a time card; this action shouldn’t be changed. Additional fields can be
added to the form, which My C&P! will process when the time entry is
saved. The time entries cost and billing rates are calculated by My C&P!
when the time entry is saved.

Add Expenses, Add Internal Charges Add Expenses, Add Internal Charges Add Expenses, Add Internal Charges Add Expenses, Add Internal Charges Add Expenses, Add Internal Charges  The expenses.htm page resembles
Add Expense Report window in Clients & Profits. The page features a form
that prompts a user to enter the individual expenses. The list at the bottom
of the page displays the user’s expense entries for each day. The
add_internal_charge.htm web page lets users track costs for internal
charge items, like CD duplication and film output. This feature is only
available to Clients & Profits Pro and Job Tracker users, since Clients &
Profits Classic doesn’t track internal charges. (The Add Internal Charges link
only appears if the Clients & Profits database contains internal charge item
records.)

Lookups Lookups Lookups Lookups Lookups  The lookup pages are identical to the Lookup List windows in
Clients & Profits, except that they don’t allow new records to be added. The
design of the lookup pages is slightly different from other My C&P! web
pages since they have the unique purpose as reference lists. The content of
the lookup lists are built via CGI and can’t be modified.

Online help  Online help  Online help  Online help  Online help  Each My Clients & Profits! web page has a link for online help
at the bottom. Depending on which page is being used, clicking on the help
link opens one of six different help pages: help_clients.htm, help_exp.htm,
help_jobs.htm, help_POs.htm, help_time.htm, and help_traffic.htm in
addition to a generic help.htm page. The help.htm contains general
information about how to use My Clients & Profits! web pages, while the
other help pages offer specific instructions and guidance for each special
function. The text on these pages is very general and should be customized
with your own instructions for using My Clients & Profits!
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Adding your own web pages and PDFs to My Clients & Profits!Adding your own web pages and PDFs to My Clients & Profits!Adding your own web pages and PDFs to My Clients & Profits!Adding your own web pages and PDFs to My Clients & Profits!Adding your own web pages and PDFs to My Clients & Profits!

In addition to its own web pages, My Clients & Profits! can serve your own
custom web pages and Adobe Acrobat PDF files. Any page or PDF file
stored inside the My C&P! HTML folder can be accessed using a link on any
web page. (For an example of how to link a web page to My C&P!, see the
“company handbook” source code on the home.htm page.) My Clients &
Profits! web pages can end in either .htm or .html.

Custom home pages for specific My Clients & Profits usersCustom home pages for specific My Clients & Profits usersCustom home pages for specific My Clients & Profits usersCustom home pages for specific My Clients & Profits usersCustom home pages for specific My Clients & Profits users

Each user can have a completely custom home page. First, create a home
page by duplicating home.htm, home_admin.htm, home_client.htm, or
home_vendor.htm then redesign it. Be sure to give each custom home page
a unique name, since it will be entered into a user’s web account (see page
20). When a custom home page is specified in a user’s web account, My
C&P! displays it instead of the standard home page whenever that user logs
in.

Tips for customizing My Clients & Profits! web pagesTips for customizing My Clients & Profits! web pagesTips for customizing My Clients & Profits! web pagesTips for customizing My Clients & Profits! web pagesTips for customizing My Clients & Profits! web pages

Customizing your HTML pages for My Clients & Profits! is relatively easy,
depending on your skills as a web page designer. You can use advanced
web design software like Microsoft FrontPage, Macromedia Dreamweaver,
Adobe GoLive or very basic editors such as Netscape Composer, which is a
component of Communicator. Text editors, such as WordPad, can also be
used to make quick changes to web pages.

�  Do not change the <OMFLD>CONTENT</OMFLD> tags except to adjust
their position to accommodate a new design.

�  Changing the banner.gif graphic will affect all pages, since they all use
the same banner. Custom banners can be added to any page by moving the
graphic into the Images folder then modifying the page’s HTML code to
display the new banner.

�  Before redesigning any My Clients & Profits! page, make a backup copy
of the page first. If your changes somehow break the page, you’ll need to
restore an original copy of the page and start over.

�  Before adding new graphics to your web pages, remember to place your
web graphics in the Images folder, which is inside the HTML folder.

�  All web pages need to have the following copyright statement in the
HTML source code:  <!--This page is part of the My Clients &
Profits! web server  © 2003 Clients & Profits, Inc. All Rights

Reserved-->

�  All web pages need to have the following copyright text at the bottom
of each page:  This page is part of the My Clients & Profits! web
server © 2003 Clients & Profits, Inc. All Rights Reserved

Customizing the “my_script.js” JavaScript fileCustomizing the “my_script.js” JavaScript fileCustomizing the “my_script.js” JavaScript fileCustomizing the “my_script.js” JavaScript fileCustomizing the “my_script.js” JavaScript file

The my_script.js file is a JavaScript document that contains style
information that determines how data is formatted on web pages. It is also
used to format data correctly on forms (e.g., converting lower case letters
to all-caps, checking for invalid dates, etc.). Each My C&P! web page looks
for the my_script.js file when it is opened.

To make enhancements quicker and easier, the my_script.js file is served
from the Clients & Profits web site. However, you can serve the my_script.js
file from your own server if you host your own web site (using an outside
ISP won’t work). Use this option if (1) you want to customize the JavaScript
file or (2) if web pages load faster from your own server. To server your own
JavaScript file, move the my_script.js file from My C&P!’s HTML folder onto
your web server then enter your web server’s URL into Preferences (see
page 17).
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Appendix A: Security Issues

My Clients & Profits! was designed to offer reasonable security to the
shop’s Clients & Profits database, while making it available to the widest
number of users. It is a custom, proprietary HTTP server, so can’t be
accessed anonymously like other web servers.

The My Clients & Profits! server itself contains no company data. All of the
data it uses is stored in the Clients & Profits database on your file server. If
My C&P! can’t access your file server for any reason, then it can’t serve
data to web users.

The My C&P! web pages themselves contain no company data, either.
Pages contain tags (called OMFLDs; see page 30) that are used by the My
C&P! CGI to access records from the shop’s Clients & Profits database. A
web page only shows actual data when it is processed by the My Clients &
Profits!’s CGI, which can only happen if someone logs on with a valid user
ID and password. If someone copies an HTML page from My C&P!, they will
only see the page’s OMFLDs. This effectively prevents spiders and bots from
indexing My Clients & Profits!

The server does not support SSL, so cannot establish secure encrypted
connections between users and the web server. For this reason, My Clients
& Profits! offers only limited access to your accounting data. There is no
access whatsoever to anything financial, such as checks, client payments,
or the general ledger.

My Clients & Profits! contains many built-in security features which, when
used together with responsible management practices, help ensure that
confidential company data stays private.

My Clients & Profits!’s security features include:

Starting My Clients & Profits!Starting My Clients & Profits!Starting My Clients & Profits!Starting My Clients & Profits!Starting My Clients & Profits!  Only Clients & Profits system managers can
configure the C&P database for My Clients & Profits!, set up web users,
then start the web server.

Individual user accountsIndividual user accountsIndividual user accountsIndividual user accountsIndividual user accounts  While My Clients & Profits! can be accessed from
any internet connection, it is not a publicly available server. It is only
accessible to staff members, freelancers, clients, and vendors who are
authorized My C&P! web users. Each individual person has their own web
account, including people who work for the shop’s clients and vendors.
Users can’t create their own accounts; instead, they must be set up by the
My C&P! web server administrator. User accounts can be set to expire at a
selected date.

User passwords  User passwords  User passwords  User passwords  User passwords  Each web account has its own password. Passwords are
not defined by the user; instead, they must be assigned by the My C&P!
web administrator (“webmaster”). User passwords can be set to expire at
certain dates to help keep passwords from being circulated. Passwords are
stored in the Clients & Profits database as encrypted data.

Appendix A: Security Issues

Access PrivilegesAccess PrivilegesAccess PrivilegesAccess PrivilegesAccess Privileges  The functions that a web user can see and do are based
on their My Clients & Profits! access privileges. Each web user can be given
access to clients, jobs, time cards, expenses, etc. by the My C&P! web
administrator. Clients and vendors have limited access to the database,
while staff members and freelancers can add jobs, edit estimate, etc. based
on their access privileges to Clients & Profits.

No guest accessNo guest accessNo guest accessNo guest accessNo guest access  There is no temporary “guest” access to the My Clients &
Profits! web server. Unlike other web sites, anonymous users can’t create
their own My C&P! account and get temporary, limited access to the
system. Instead, user accounts can only be created and managed by a My
C&P! web administrator.

Cookies control user accessCookies control user accessCookies control user accessCookies control user accessCookies control user access  Cookies must be enabled on the users’
browsers to access the My C&P! web server. When a user successfully logs
onto My C&P!, a cookie is automatically set in their browser that lasts for
24 hours. The user can then repeatedly access My C&P! web pages during
that period without reentering their ID and password. The cookie’s
expiration date can be changed (for example, to a week instead of one day)
by changing the Javascript in the introduce.htm page.

No bookmarksNo bookmarksNo bookmarksNo bookmarksNo bookmarks  Web users can only access My Clients & Profits! from the
“introduce yourself” page. This ensures that My C&P! knows exactly who
has accessed every web page. If a user bookmarks any My C&P! page (other
than the Introduce Yourself page) the server will open the introduce page
instead.

Restrictions to client, vendor accounts Restrictions to client, vendor accounts Restrictions to client, vendor accounts Restrictions to client, vendor accounts Restrictions to client, vendor accounts  A web user can be restricted to
seeing only one client’s account information, jobs and costs as part of their
access privileges. The same restriction can be made to web users who are
vendors; they are limited to only seeing their POs. This option can be used
with staff members and freelancers, as well as clients. Vendors can’t access
client information in any way, and clients can’t see vendor data.

Failed login notificationFailed login notificationFailed login notificationFailed login notificationFailed login notification  A notify webmaster of failed logins via e-mail
preference (see page 17) automatically sends an alert via e-mail to the My
C&P! webmaster whenever someone tries to access the web server with an
invalid user ID or password. An entry is also made in the server’s web log.

Bad password notificationBad password notificationBad password notificationBad password notificationBad password notification  My Clients & Profits! will notify the webmaster
via e-mail whenever a web user tries to log onto the server with a bad
password.

3 bad passwords suspend web accounts3 bad passwords suspend web accounts3 bad passwords suspend web accounts3 bad passwords suspend web accounts3 bad passwords suspend web accounts  The optional disable web accounts
after 3 bad passwords preference will automatically suspend a web account
if the user enters a bad password three times in a row. The user will see an
error page explaining why their account has been suspended, and the My
C&P! webmaster will be notified via e-mail. The account can be reactivated
from the My C&P! user access window (see page 20) or remotely from the
user access web page.
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All hits are loggedAll hits are loggedAll hits are loggedAll hits are loggedAll hits are logged  The activity log tracks all hits to the My Clients &
Profits! web server. For faster performance, logging can be stop by enabling
the disable activity log preference—but then you’ll have no idea of who’s
using My Clients & Profits! and what they’re doing.

Users are tracked by IP addressUsers are tracked by IP addressUsers are tracked by IP addressUsers are tracked by IP addressUsers are tracked by IP address  The My C&P! Server Status window shows
the IP address of every current and recent web user, helping webmasters
track down who’s using the server. If a user who’s connected to My C&P!
logs in from a different computer, the new IP address replaces the original
one.

Only web administrators can remotely monitor My C&P!Only web administrators can remotely monitor My C&P!Only web administrators can remotely monitor My C&P!Only web administrators can remotely monitor My C&P!Only web administrators can remotely monitor My C&P!  Unless the web
server administrator option is enabled for a web user, he or she won’t be
able to remotely monitor or manage the My C&P! web server.

Remote administration is an optionRemote administration is an optionRemote administration is an optionRemote administration is an optionRemote administration is an option  If the allow remote administration
preference is unchecked, the home page links for server status, users,
activity log, and preferences are not available. This prevents anyone
outside the office from monitoring the My Clients & Profits! server.

Remote administration can be limited to a preset IP addressRemote administration can be limited to a preset IP addressRemote administration can be limited to a preset IP addressRemote administration can be limited to a preset IP addressRemote administration can be limited to a preset IP address  The restrict
remote administration preference allows a web administrator to remotely
monitor and manage the My Clients & Profits! server from a single specified
IP address. If anyone else tries to remotely administer the server from a
different computer they will be rejected.

Security Tips for My Clients & Profits!

�  Don’t let users share the same web account.

�  Use long passwords of random characters and number instead of
recognizable names, words or phrases.

�  Use the automatic e-mail notification for errors and bad logins.

�  Change web user passwords frequently.

�  Check the web log for excessive or suspicious use by particular
users
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Appendix B: Setting up My C&P! as a
Windows 2000/XP Service

If you are using a Windows 2000/XP server, you can set My Clients &
Profits! to automatically start up by installing it as a service. This is the
only way to automatically launch My C&P! when the server starts up.
Otherwise, a web administrator will have to manually launch My Clients &
Profits! every time the Windows server is restarted.

Setting up My C&P! as a service has three steps: (1) installing the My C&P!
softare, (2) installing the service, and (3)
configure Windows 2000/XP to auto log
on at startup.

�  For the Windows 2000/XP service to
work correctly, the My Clients & Profits
directory has to be named
MyClientsProfitsMyClientsProfitsMyClientsProfitsMyClientsProfitsMyClientsProfits. If you move or rename
this directory, Windows won’t be able to
find the My C&P! application.

Before you can configure My Clients &
Profits! as a Windows 2000/XP service,
the My C&P! software must already be
installed (see page 12).

The My Clients & Profits! installer copies
the MyClientsProfits directory onto the top
level of the server’s C: drive by default.
You can move the MyClientsProfits
directory anywhere you want before the
service is installed. The service is linked to
the location of the MyClientsProfits
directory. Once the service is installed, if
you move the directory then My Clients & Profits!
won’t automatically start.

To install the My Clients & Profits! serviceTo install the My Clients & Profits! serviceTo install the My Clients & Profits! serviceTo install the My Clients & Profits! serviceTo install the My Clients & Profits! service

11111  In Windows 2000 or Windows XP, choose Start > Programs > Accessories
> Command Prompt.

2 2 2 2 2  Type cd myclientsprofits then press Return.

33333  Type myserv -install then press Return.

The Command Prompt responds with a message “My Clients & Profits
service installed.”

44444  Click the Command Prompt’s close box.

Next, you’ll need to configure the new MyClientsProfits service using
Window’s administrative tools.

Appendix B: Setting up My C&P! as a Windows 2000/XP Service

55555  Choose Start > Settings > Control Panels then double-click on the
Administrative Tools control panel.

66666  Double-click on the Services administrative tool.

The Services administrative tool lists all of the services installed on your
Windows 2000/XP server.

77777  Double-click on the My Clients & Profits
service.

The My Clients & Profits service Properties
window opens, displaying the settings for the
service.

88888  Click on the Startup Type pop-up menu,
choose Automatic, then click OK.

99999  Close the Services window, then close the
Administrative Tools window.

�  The first time you run My C&P! choose
Setup > Preferences and make sure the always
start web service automatically at startup
option is checked. This tells My C&P! to start
listening for hits at startup.

�  If you move the MyClientsProfits directory
after installing the service, you’ll need to
remove the service and reinstall it.

To configure Windows 2000/XP to automatically log onTo configure Windows 2000/XP to automatically log onTo configure Windows 2000/XP to automatically log onTo configure Windows 2000/XP to automatically log onTo configure Windows 2000/XP to automatically log on

When Windows 2000/XP starts up, it prompts the user for an ID and
password. In order for the server to start up unattended, it must be
configured to automatically log on. This involves a security risk, somone
could access the server without having to enter an ID and password. But
this is the only way to automatically start My Clients & Profits! after the
server’s been powered on.

Configuring Windows 2000/XP to automatically log on involves editing the
Windows registry. You’ll find step-by-step instructions here: http://
support.microsoft.com/default.aspx?scid=kb;EN-US;q310584. Once these
steps have been completed, restart the computer and My Clients & Profits!
will start automatically.

Auto startup Windows will
automatically start My C&P!
once you’ve set the service’s
Startup Type to “automatic”.
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Appendix C: Custom Home Pages

Individual users can be given their own custom home page. Custom home
pages should be based on the standard home pages, but can be completely
redesigned (for example, completely stripped of graphics to accomodate
palm PCs or other wireless internet devices). This lets custom home pages
be highly creative and expressive (there’s no real limit to its look and feel).
The same custom home page can be shared by several different users (for
example, a custom home page for the traffic department).

There are two steps to implementing custom homes pages: (1) creating the
page then (2) defining the custom home for a user.

To create a custom home page for an individual userTo create a custom home page for an individual userTo create a custom home page for an individual userTo create a custom home page for an individual userTo create a custom home page for an individual user

11111  From the Windows or Macintosh desktop, find and open the HTML folder
inside the My Clients & Profits! folder.

22222  Click on a standard home page then duplicate it.

33333  Give the new home page a unique name (e.g., home_chris.htm)

4  Using an HTML editor (such as Dreamweaver or FrontPage), modify the
user’s home page as needed.

55555  Save the new home page into the My C&P! HTML folder.

This custom home page is now ready to define to a web user.

To define a user’s custom home pageTo define a user’s custom home pageTo define a user’s custom home pageTo define a user’s custom home pageTo define a user’s custom home page

Before the user can use his or her custom home page, the page’s name
needs to be defined in the user’s web account in My Clients & Profits! This
can’t be done while the server is running, and the user’s custom home page
can’t be defined remotely.

�  If the My C&P! web server is running, temporarily disable it by clicking
the Stop Server button (or by choosing Control-S in Windows or Command-
S on a Mac).

11111  Choose Setup > Users, Access & Passwords.

22222  From the My Clients & Profits! Users window, double-click on a user
name then click on the General button.

33333  From the General Privileges window, enter the custom home page’s
name or click the Get Page link then locate the user’s home page in the
HTML folder.

44444  Click Save then close the User Access windows.

55555  Restart the web server by clicking the Start Server button (or by choosing
Control-S in Windows or Command-S on a Mac).

The user’s custom home page will be available instantly once web service
has been started.

/clients View client accounts
/job_tickets Job tickets, estimates, schedules, creative briefs
/add_job Open new job tickets
/find_job_status Daily Job Status report

/find_weekly_traffic Weekly Traffic report

/task_planner Daily Task Planner

/find_work_to_do Work to Do

/find_client_status Client Job Status report

/login Opens the Introduce page

/proposal View, add, edit, and print client proposals

/prod_plan View the shop’s production planner

/PO View purchase, insertion, broadcast orders

/add_PO Add new purchase orders

/expenses Add employee expense reports

/internal_charges Add internal charges

/time_card View, add, edit time on daily time cards

/availability View, add staff availability calendar entries

/in_out_board Track who’s in and out of the office

/lookup_clients Lookup list of active clients

/lookup_jobs Lookup list of open jobs

/lookup_staff Lookup list of staff members

/lookup_status_codes Lookup list of production/billing status codes

/lookup_task_table Lookup list of task table

/lookup_groups Lookup list of task groups

/lookup_POs Lookup list of open purchase, insertion, broadcast orders

/lookup_job_types Lookup list of job type/spec sheets

/lookup_projects Lookup list of client projects

/admin_status Current web server status

/admin_log View the day’s web server activity

/admin_users Remotely edit a  My C&P! web users’ access privileges

/admin_prefs Remotely edit the web server’s preferences

Link Access to

Selected My Clients & Profits! Home Page Links
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Index

Index

AAAAA

Access button  19
access privileges  8, 19—21
account suspended option  20
Account/Password Expiration
      report  26, 27
accounting data  34
Acrobat, Adobe  32, 33
activity logs  24—25
     activity log link  29
     Activity Log Report  24
     automatic archiving  17, 25
     disabling logs  17, 34
     exporting logs  25
Add Expenses link 33
Add Internal Charges link  33
Add New User link  29
Adding your own web pages  33
administrator  8
     also see webmaster
Adobe Acrobat  32, 33
allow remote administration
     option  7, 25, 28—29
always start web service at startup
     option  17
authorized users  8, 18—21
Auto-create web users  7, 18
automatic e-mail  17
automatic quit setting  22

BBBBB

backups, nightly  22
     setting close/reopen times  17
bad password, handling  17, 34
bad password option  17
banner graphic  30
bookmarks  34
bots  34

CCCCC

C&P database  see database
C&P Player  13, 15
CGIs  30, 32
changing a page design  30—33
clients  4, 8
     security issues and  34
     restricted to option  20
     web access for  18, 24

company calendar links  29, 32
company data  34
company forms links  32
company handbook links  30, 32
company news links  32
Connected Users list  23
connection failure has occured
     error  22
CONTENT tag 30
cookies 34
Create Password button  20
cross-platform capabilities  6
custom home page  20, 33, 37
customizing web pages  3—033

DDDDD

DNS server  7
Daily Job Status  32
Daily Time Card  33
data dictionary  30
database  9, 12, 14, 22, 34
DATE tag  28
department  20
disable activity log option  17
domain name  8

EEEEE

encrypted connections  34
error checking  8
error message  22
expiration dates, account  20
exporting log entries  25

FFFFF

failed logins option  17, 34
field names  30
file server  6
Find Log Entries function 24
forms  30
free-lancers  4, 8, 20
functions, on home page  5

GGGGG

General reports  27
GIFs  31
GREETING tag  30, 31
greeting  15

guest access  18, 34

HHHHH

handbook, company links  32
hard disk  6
help, online  33, 37
hits  23, 24, 35
hits per hour graph  22, 23
home computer, using a  16
home page  8, 31, 37
     see also custom home page
HTML folder  6, 15, 28, 30—33
HTTP server  8, 12, 14, 36

IIIII

industry news links  4, 5, 32
installation  6, 12
internet  6
intro greeting  17
introduce yourself page  8, 15, 29
IP address
     for connected users  23
     for the My C&P! web server  6
     on web logs  24
     restrict remote admin to  17

JJJJJ

JavaScript  17, 33
Job Tickets  32
jobs access privileges  20

KKKKK

kinds of users  18—19, 20

LLLLL

Laptops  16
Client Job Status  32
LINKS tag  30
links, home page  31—32
log web server errors  17, 29
logs, activity
     see activity logs
LOOKUP tag  30
lookup lists  5
Lookup menu  22
Lookups  32

MMMMM

Mac OS X  14
Macintosh  14-15
mail server  17
monitoring the server  22—23, 28
monitoring the server log  29
multiple databases  12, 14
my_script.js  17, 33
My C&P! folder  6, 12, 13, 14, 15
MYSERV  36

NNNNN

nightly backups
     see backups
no web access after option  20
notify about server errors option
     17
OOOOO

OMFLDs  30—33, 37
online help  33, 37
Open New Job link  32

PPPPP

padlocks  8
passwords  8, 12, 14, 20, 34
PDF files  5, 32, 33
Peak Usage report  27
performance  28
performance factors  8
performance reports  27, 29
preferences  7, 16—17
preferences link  29
printing server reports  26
Purchase Orders link  32

RRRRR

RAM  6, 12
remote administration  28—29
reports  27
reset button  23
resetting My C&P!  22
restart at time  17, 22
restrict remote administration
     option  17, 35
restrict remote administration to
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     IP address option  28
restricted to option  20
restrictions, security  36
restricting remote administration
     28

SSSSS

security  16, 34—35
serial number  6
server reports  27
server status link  28
server usage  28
service, Windows  36
SMTP server  17
sound bell on hits option  17
spiders  34
SSL  34
staff members  4, 8, 18—21
starting My C&P!  22
starting web service  22
statistics  25
stop at time  17, 22
stopping the web server  22
style sheets  33
suspended accounts  20, 34
system requirements  6
     Macintosh  14
     Windows  12

TTTTT

table font/size  17
TCP/IP  6
technical help  6
“temp” password  18, 19
temporary password  18, 19
temporary access  34
Time Card link  33
Today’s Activity list  22, 24
Traffic link  30, 32
Traffic access privileges  20, 21

UUUUU

user accounts  19—21
user ID  8, 12, 14, 18, 19, 20
user list  19
Users, Access & Passwords  7, 18
users link  29
Users web page  29

Users window  18
utilization reports  25

VVVVV

vendors  4, 8, 18, 19, 20, 34

WWWWW

webmaster  16, 17, 24, 26, 28
web accounts  18
web address  4, 8
web administrator  8,
     also see webmaster
web ID  4, 7
web logs  see activity logs
web pages  5, 28, 34 
web server administator option  
      20, 28, 34
Web Server Status window  12, 23
web user accounts  7
web users  18
webmaster  8, 17
webmaster e-mail address  17
Weekly Task Planner  32
welcome message  20
Windows 2000  6, 12
Windows 98  6, 12
Windows 2000/XP  6, 12
      Service  36
Work To Do  32
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introduce.htm

home.htm

home_client.htm
home_vendor.htm
home_admin.htm
home_custom.htm

clients.htm

client_billing_info.htm
client_budget.htm
client_contacts.htm
client_diary.htm
client_diary_entry.htm
client_invoices.htm
client_jobs.htm
client_job_status.htm
client_project.htm
client_projects.htm
client_stats.htm
add_client_project.htm

job_ticket.htm

job_diary.htm
job_diary_entry.htm
job_estimate.htm
job_schedule.htm
job_snapshot.htm
job_specs.htm
job_task.htm
job_traffic.htm
work_order.htm
change_orders.htm
change_order.htm
add_change_order.htm
edit_change_order.htm
add_client_diary.htm
add_job.htm
add_job_diary.htm
add_job_tasks.htm
creative_brief.htm
printing_specs.htm
print_spec.htm
estimate_options.htm
print_estimate.htm
task_costs.htm
task_POs.htm
task_billings.htm

expenses.htm

edit_expense.htm

lookup_clients.htm
lookup_groups.htm
lookup_jobs.html
lookup_job_types.htm
lookup_POs.htm
lookup_projects.htm
lookup_staff.htm
lookup_status_codes.htm
lookup_tasks.htm
lookup_task_table.htm
lookup_vendors.htm
popup_jobs.htm
popup_status_codes.htm
popup_tasks.htm

add_job.htm
add_job2.htm

add_PO.htm
add_PO2.htm

daily_job_status.htm
find_job_status.htm

weekly_traffic.htm
find_traffic.htm

client_job_status.htm
find_client_status.htm

work_to_do.htm
find_work_to_do.htm

in_out_board.htm
in_out_board_logon.htm

availability.htm
avail_add.htm
avail_edit.htm

my_jobs.htm

prod_planner.htm

timecard.htm

edit_time.htm

PO.htm

PO_desc.htm
PO_item.htm
PO_options.htm
PO_specs.htm
PO_vendor_info.htm
IO_options.htm
IO_desc.htm
IO_specs.htm
print_buy.htm
BO_options.htm
BO_desc.htm
broadcast_buy.htm

My Clients & Profits! 5.0 Web Pages Flow Chart

For a description of each My C&P! web page, see www.clientsandprofits.com/my/my_web_pages.html

admin_server_status.htm
admin_server_prefs.htm
admin_server_log.htm
admin_server_users.htm
admin_web_user.htm
admin_add_web_user.htm

form.htm
calendar.htm
handbook.htm
news.htm

internal charges.htm

add_internal_charge.htm

error.htm
error_no_access.html


